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Introduction : A User's View of DataEase
Welcome to the User's Guide
Welcome to the DataEase User's Guide. This guide explains how to start DataEase and sign
on to a custom application, open previously designed record entry forms, view records, print
reports, and use the following special features:
•

Application Catalog

•

Toolbar

•

Query By Form (QBF)

•

Query By Model (QBM)

•

DataEase Multiforms

•

Command Buttons

•

Custom Menus

•

Dynamic Data Exchange (DDE)

•

Object Linking and Embedding (OLE)

•

Transparent SQL Connectivity

This documentation includes an introduction to the DataEase graphical user interface, special
guidelines for using DataEase in a Client-server environment, and reference information for all
data entry, record searching, database administration, and routine maintenance tasks that the
users of an application need to understand.

Who Should Read this Documentation
This guide is written for people who enter and modify data, search for information, run
predefined reports, and carry out other day-to-day tasks to manage data in a custom
application.
If you are not familiar with DataEase, we recommend that you begin by performing the handson lessons in the DataEase Quick Start Guide (QSG).
If you are responsible for designing custom applications, you'll find reference information on
creating tables, forms, reports, and menus, defining relationships, and other database design
guidelines in the DataEase Designer's Guide (DG).
If you are an application designer, system administrator, or experienced user who wants to
extend the power of your applications by creating DataEase Query Language (DQL) programs,
you'll find the information you need in the DataEase DQL Programmer's Guide (DQL).
Note: If you haven't installed DataEase, follow the installation instructions in Appendix A at
the back of this guide. For information about using DataEase to access an application built with
a character-based version of DataEase, see the Conversion Guide.

© DataEase International Ltd

10

How this Documentation Is Organized
This documentation is organized into three sections, as follows:
Section I, Orientation, includes several introductory chapters that present a general overview
of the features available in User View. If you have never used DataEase before, we
recommend that you read this section before trying to use the software. Section I contains
Chapters I-2.
Section II, Menus, includes a separate chapter for each menu in User View. These chapters
are presented in the order the menus appear on the Menu Bar, beginning with the File menu
on the left and ending with the Help menu on the right. Section II contains Chapters 3-10.
Section III, Appendices, includes one or more appendices (identified by the alphabetical
characters A, B, C, etc.) that contain infrequently used technical information, such as special
Client-server environment guidelines. Section III contains Chapters A-B.

Typographical Conventions
Throughout the DataEase manuals, we've used the following typographical conventions to
make the documentation easier to understand.
Term

Typeface Used

Example

Glossary Term

Italic

Data Model

Menu Option

Bold

File>>Open

Function Key

Uppercase

F7 DELETE RECORD

Document/Table Name

Uppercase

MEMBERS

Field Name

Small Capitals

FIRST NAME

DQL Term

Bold Lowercase

highest of

SQL Command

Uppercase

CREATE TABLE

Glossary terms with special meaning in DataEase are printed in italics the first time they occur
in the text and are defined in the on-line glossary available in Help.

Getting Help
The Help menu on the right end of the Menu Bar is used to access the DataEase Help system.
The DataEase Help system is a separate hypertext program that runs in its own moveable,
resizeable window and operates concurrently with DataEase. This program uses many of the
standard navigational tools the Windows Help system provides.
To quickly access the DataEase Help system, press F1 HELP. To display specific help on a
menu option, dialog, or Toolbar button, press Shift + F1 CONTEXT-SENSITIVE HELP.
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Sample Application
Club ParaDEASE, the sample application shipped with DataEase, is based on a fictitious
travel industry organization. This application is used throughout the DataEase documentation
to illustrate data entry, application query, form/report design, and other important procedures,
and help you learn how to use a DataEase application in a realistic context.
Our sample application, Club ParaDEASE, runs an expanding set of resort clubs situated in
exotic locales around the world. Each club provides the setting for a week-long vacation
package, with air/land travel arrangements, accommodations, and other hospitality services
included at a discount price. Special facilities, equipment, and intensive training workshops are
offered for various sport activities at each club.

How Club ParaDEASE Works
Club ParaDEASE uses forms to enter, update, and report information about Clubs, Activities,
Members, Reservations, and other aspects of club business. The CLUBS form is shown
below.
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What Is DataEase?
DataEase is an innovative program that combines the organizational power of the DataEase
relational database management system with the popular and easy-to-use graphical user
interface of Microsoft Windows. This unique combination of native relational database power,
instant SQL connectivity, and point-and-click desktop application development makes
DataEase the premier tool for building sophisticated business applications.

Visual Database Applications
DataEase is a visual database manager that integrates any kind of graphical information
(photos, line drawings, scanned images, etc.) with the text and numerical information normally
found in a business database. DataEase lets you include pictures of people, places, and
objects in a fully relational database application. This feature makes DataEase an ideal tool for
managing all kinds of visually-oriented data, such as art and advertising comps, blueprints and
engineering drawings, manufactured part assemblies, personnel records, etc.

Client-Server Applications
See USER GUIDE Appendix B for information about using DataEase in a Client-server
environment.
See USER GUIDE Chapter 1 for information about the Windows environment.
When DataEase first appeared, many organizations were just beginning to migrate from paperbased file systems to computerized record keeping. Today, in contrast, most business
organizations have accumulated a vast amount of data that now exists in a variety of formats
from different vendors. Using industry-standard ODBC drivers, DataEase provides instant,
completely transparent connectivity to any number of existing data sources, including IBM
DB2, Microsoft/Sybase SQL Server, Oracle Server, and other leading SQL database engines.
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Microsoft Windows Environment
Because DataEase runs in the Microsoft Windows environment, you may already be familiar
with its pull-down menus, dialogs, and mouse-controlled selection techniques. Unlike other
database systems, you don't have to memorize complex commands to enter data, find specific
records, or run reports.
If you haven't used Windows previously, be sure to read the Microsoft Windows User's
Guide. Most Windows programs use similar techniques to open, print, and close files; cut,
copy, and paste data; and perform many other standard operations.
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Terms and Concepts
This section provides some brief definitions to help you understand how DataEase works and
what it can do. Terms are introduced in alphabetical order.

Application
A DataEase application is a custom program that performs organization, calculation, and other
business record-keeping and reporting tasks. With DataEase, organizations can quickly create
customized applications that track customers, sales, appointments, reservations, employees,
expenses, or any other type of data.

Database
A database is simply a collection of related information (data). An example of a commonly
used database is the phonebook. A DataEase database contains data stored in the DataEase
Native engine format.

Database Table
The data in a database is stored in one or more tables. Each table is a rectangular array that
holds data about one specific entity (a person, place, or thing). A database table consists of a
varying number of named columns and unnamed rows. Each column in a table defines one
attribute of the entity (e.g., last name, first name, department, salary, etc.). Each row
represents one instance of that object (e.g., the name, department, and salary of a particular
employee).
EMPLOYEES
EMPLOYEE

LAST

FIRST

ID

NAME

NAME

DEPARTMENT

SALARY

425

Carlyle

Robert

Accounting

24800

524

Delucca

Anthony

Sales

26380

525
630

Prentiss

Barbara

Sales

27400

Black

Michael

Shipping

25625
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Document
A document is an application object that is used to enter, view, manipulate, or print data, or
simply help a user move from one part of the application to another. A DataEase application
can contain four types of documents: form, report, menu, or procedure.

Form accepts, validates, and displays data stored in one or more database tables. A form is
used to enter, view, modify, delete, or search for records on the screen.
Report displays data from one or more tables in a convenient layout on screen or on paper. A
report is frequently used to print a list of sorted and/or grouped records to help the user
analyze a specific set of data. You can use QBF (Query By Form) or QBM (Query By Model) to
filter the data displayed in a report or form.
Menu displays a list of choices. Each choice tells DataEase to perform a specific task, such as
open a form or print a report.
Procedure lets you use the DataEase Query Language (DQL) to perform a task(s), such as
generate a report, manipulate data directly, or control access to an application.
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DQL
DataEase Query Language (DQL) is the language used to define and manipulate data in the
DataEase Native engine format. See Appendix A, Using DataEase in a Client-Server
Environment, for more information about the DataEase Native database engine.

Field
A field is a document object that corresponds to a column in a database table. A field
represents the smallest complete unit of information about one person, place, or thing.

Multiform
A Multiform is a set of two or more related forms that appear on the screen at the same time
and behave as if they were a single form. A Multiform is made up of a Main form and one or
more Subforms.

Record
A record is a document object that corresponds to a row in a database table. A record consists
of a collection of fields that contains information about one person, place, or thing.

Object
An object is any element in an application that displays data (e.g., a field, record, or form) and
has physical properties (e.g., size, shape, or color) and/or functional properties (such as the
ability to be moved or resized, or to execute a single command).
An object-oriented application like DataEase lets you create objects that combine graphic and
alphanumeric data and that can invoke actions that display, derive, or manipulate data.
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For example, in the figure below, which shows a Clubs holiday reservations form, each club
has graphic presentation attributes (types of activity) and alphanumeric data attributes (number
of rooms, prices, etc.). When you click on the Reservations button, DataEase opens a
Reservations form which lets the bookings clerk enter the customer's name, address, credit
card information, and so on.
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Query
A query is a series of instructions that tell DataEase to retrieve a specific set of records in the
database. Query By Form is an easy-to-use query method in which you enter sample data
(called selection criteria) into fields on a record entry form without programming. In response to
the query, DataEase retrieves all the records that contain exact matching values in these
fields.
DataEase provides two query tools:
•

Query By Form (QBF), which lets you filter, sort, and view selected records by entering
sample data in the same form you use to enter data.

•

Query By Model (QBM), which lets you select rows and columns from multiple
database tables, compute summary statistics, and design a new layout for the retrieved
data using a graphical data model of your information.

Relationship
A relationship is a link between two database tables. For two tables to be related, they must
each contain one or more columns that are the same in each table. These match columns
provide the link that identifies a row in one table as related to a row in the second table. When
two tables are related, you can access information in one table while processing data in the
other table. Because this relationship is stored in the database, it can be used in different
procedures whenever necessary.
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Report
A report is a document that lets you retrieve, sort, and group specific sets of records and
display (or print) selected fields in the layout you specify. A report is live (interactive) or static.
A report is static after it is sent to a printer, a disk file, or an on-screen window.

SQL
Structured Query Language (SQL) is the widely used language for defining and manipulating
data stored in different database engine formats. See Appendix A, Using DataEase in a
Client-Server Environment, for more information about different database engines.
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Subform
A Subform is a form that is embedded in a Multiform to display related records. Before you can
define a Multiform, you must create the Main form and each Subform separately. Then you
must define a relationship between the Main form and each Subform. When you display a
Multiform, it appears as if there is only one form on the screen. However, as you modify data,
you are actually editing data in multiple tables simultaneously.

Toolbar
The Toolbar is the row of buttons DataEase displays directly under the Menu Bar, providing
instant access to frequently used menu options. To execute an option, you simply click the
corresponding Toolbar button. DataEase provides two Toolbars: one when the document in
the active window is displayed in User View and another when the document is displayed in
Designer View.

View
A view is a document that displays data from one or more related tables in a single layout. The
document hides data from certain users or simply make it easier to enter new data or analyze
existing data. Think of a view as a special window through which different users can examine a
subset of the data in the database.
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Creating, Opening, and Deleting Applications
See DESIGNER GUIDE Chapter 1 for additional Desktop File menu options.
When you start DataEase, before you sign on to an application, DataEase displays the
Desktop Menu Bar, which lets you create an application, open an existing application, delete
an application, and get on-line Help.

Creating an Application
When you choose File>>New Application, DataEase displays the New Application dialog
shown below. This dialog is used to specify the name of the application, the location in which
you want to store the application, and the User Name and Password you want to use to gain
access to the application in the future.

New Application Dialog Options
Application Name lets you assign a name of up to 20 characters to the application.
Directories tell DataEase which directory stores your application. To select a directory,
double-click on the name of the directory.
Note: We recommend that you store each application in a separate directory. To create a
directory, use Windows File Manager.
Drives tell DataEase which disk drive stores your application. To select a drive, click on the
drop-down arrow and then on the drive letter.
When you complete the New Application dialog and click OK, DataEase displays the
Application Security dialog shown below.
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The Application Security dialog lets you enter the Name and Password you want to use when
signing on to an application. Use:
•

Name to enter a User Name of up to 15 characters. The Name can include uppercase
and lowercase characters, spaces, symbols, and ANSI characters (accessed by
pressing Alt and typing a value between 1 and 255 on the numeric keypad).

•

Password to enter a Password of up to 8 characters. Password accepts the same
characters as Name. During sign on, DataEase masks the Password with asterisks so
that other users can't read it.

When you create an application, DataEase automatically stores the Name and Password
combination you enter in the Users System form and assigns you a High Security Level.

Opening an Application
When you choose File>>Open Application, DataEase displays the Open Application dialog
shown below. This dialog lets you open an existing application. Only one application can be
open at a time.

After you open an application, but before you open any documents, DataEase displays the
Menu Bar but activates only the File, View, Application, and Help menus.
These menus let you create a document, open an existing document, use the Application
Catalog, activate or deactivate the Toolbar and Status Bar, perform system administration
tasks (e.g., add users, set application preferences), and get Help. Once you open a document,
DataEase activates all the menus.
When you complete the Open Application dialog and click OK, DataEase displays the
Application Security dialog. This dialog, which requires you to enter your assigned User Name
and Password to access the application, is explained on the previous page.
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Deleting an Application
When you choose File>>Delete Application, DataEase displays the Delete Application dialog.
This dialog is used to delete an entire application, including all documents and data. Once an
application is deleted, it is permanently erased.

When you complete the Delete Application dialog and click OK, DataEase displays the
Application Security dialog. This dialog, which requires you to enter your assigned User Name
and Password to access the application, is explained in the section, New Application Dialog
Options, earlier in this chapter.
Before DataEase deletes an application, it displays the Delete Application alert message
shown below.

The Delete Application alert message lets you confirm or cancel the deletion of your
application. Click:
•

OK to delete the entire application of all its files.

•

Cancel to leave the application intact.

Note: If there are forms that own SQL tables, DataEase prompts you before deleting each
table.
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How to Create, Open or Delete an Application
1. Choose File>>New Application or File>>Open Application or File>>Delete Application.
DataEase opens the corresponding dialog.
2. Choose the drive and directory.
3. If you are creating an application, enter a name of up to 20 characters in the Application
Name text box.
Note:If you are opening or deleting an application, click on the application name.
4. Click OK. DataEase displays the Name and Password dialog.
5. Enter a Name of up to 15 characters and a Password of up to 8 characters and click OK. If
you are deleting an application, DataEase displays the Delete Application alert message.
Click OK.
Note: When you first create an application, you have a one-time option to sign on with no
User Name and Password. This option lets you subsequently sign on by simply pressing the
Enter key twice in succession without specifying a Name or Password.
Before you can delete an application, you must enter a valid User Name/Password
combination with a High Security Level.
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Viewing Documents
The two basic views in which you can display a DataEase document are User View and
Designer View.

User View
User View is the data-oriented environment of DataEase. In User View, you can view data in
a single record or multiple records, enter new records, modify existing records, create reports,
and run previously defined reports. User View also lets you use Query By Form techniques to
find specific records in a form. The figure below summarizes the menus available when you
view a document in User View.
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Designer View
Designer View is the application design environment of DataEase. In Designer View, you
create the record entry forms, custom menus, and reports used in your application. Designer
View lets you build special features into your application, including image fields, custom
buttons, and direct links to other Windows applications (such as word processing,
spreadsheet, and presentation graphics programs).

Although most menus on the DataEase Menu Bar are available in both views, each view has
some unique menus as well as its own set of command buttons on the Toolbar.
The DataEase Designer's Guide explains the menus available when you view a document in
Designer View.

Exiting DataEase
To exit DataEase and return to the Windows Program Manager, choose File>>Exit. DataEase
prompts you to save any changes you have made in your DataEase session.
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Chapter 1 : Windows Fundamentals
Using DataEase Applications in the Windows Environment
This chapter introduces you to how DataEase operates in the Microsoft Windows environment.
The chapter describes standard Windows features, such as the Scroll Bar and Status Bar, as
well as specific parts of the DataEase user interface, including the pull-down menus, dialogs,
and Toolbars.
See the Microsoft Windows User's Guide for more information on the Windows environment.

The Microsoft Windows Environment
Unlike earlier generations of DOS programs, all Windows applications share the same basic
look and feel. This property makes them much easier to learn. The key idea that underlies the
Windows environment is that each application runs inside a moveable, resizeable window. All
Windows applications use similar menus to control accessing files, printing, editing data,
managing the various windows displayed on the screen, and getting on-line Help.
Many functions that you previously had to set up for each program now can be centrally
controlled by Windows. For example, the Windows Control Panel lets you change the colors of
various elements on the DataEase desktop. In addition, since you can run multiple windows
applications concurrently, you can switch quickly between your word processor, spreadsheet,
graphics, or database application, and transfer data easily from one document to another.
DataEase incorporates all standard Microsoft Windows features, including pull-down menus,
dialogs, buttons, graphical icons, Dynamic Data Exchange, and Object Linking and
Embedding. If you're already using other Windows applications like Microsoft Word for
Windows, Microsoft Excel for Windows, or Lotus 1-2-3 for Windows, you'll find learning
DataEase is a snap!
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The DataEase Window
A window is a rectangular area of your screen in which you view the forms, reports, or menus
in an application. DataEase itself runs in an application window, which is comprised of many
navigational and control elements. Application documents, such as forms and reports, run in
separate windows.
The parts of the DataEase Window, shown in the figure below, are explained in this section.

Parts of the DataEase Window
Control Menu Box is a special menu that lets you restore, resize, move, minimize, maximize,
and close windows, switch active windows, and switch to the Windows Task List.
Menu Bar lists the DataEase pull-down menus. When you click on the menu name, DataEase
displays the menu options. To execute a menu option from the keyboard, press Alt and the
underlined letter in the menu name (e.g., Alt + V).
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Title Bar displays the document type (Form, Report, Live Report, or Menu) followed by the
document name. If the document is displayed in Designer View, DataEase inserts DESIGN
before the document type. For example, if the MEMBERS form is opened in Designer View,
DataEase displays the following in the Title Bar:
[DESIGN Form: MEMBERS]
If the document is maximized, the word DataEase and the Application's name is inserted
before the document information. For example, if the MEMBERS form is maximized in
Designer View, DataEase displays the following in the Title Bar:
DataEase: Club ParaDEASE - [DESIGN Form: MEMBERS]
To move a window, click on the Title Bar and drag the mouse.
Toolbar lets you select commonly used commands by simply clicking on a button.
Minimize, Maximize, and Restore Buttons automatically change the size of the active
window.
Border is the outside edge of a window. To resize a window, position the mouse pointer over
the border until it changes into a two-way arrow and then drag the border horizontally or
vertically to the desired size.
Scroll Bar moves hidden parts of a document or window into view. Scroll Bars appear on the
bottom and right side of DataEase windows and some DataEase dialogs. The vertical Scroll
Bar moves the document up and down. The horizontal Scroll Bar moves the document left and
right.
Status Bar in User View, displays the status of the Caps Lock, Num Lock, and Ins
(Insert/Overstrike) keys, which record number is active, and whether you are viewing all
records or only queried records. If the document uses SQL data, DataEase displays server
messages on the Status Bar also. In Designer View, the Status Bar displays the x and y
position of the highlighted object.
Mouse Pointer is the symbol that moves in tandem with your mouse on the screen. The
pointer is used to select items on the screen.
Cursor indicates where you can type characters on the document.
Corner is a part of the border where two edges meet. To simultaneously adjust a window's
length and width, simply drag the corner in the direction that you want the window to expand or
shrink.

Open versus Active Windows
See USER GUIDE Chapter 3 for more information on opening forms and other documents.
Windows introduces two important terms for file management.
Open describes any window that contains an application or document running in memory.
When you click on an open window, it becomes active.
Active describes the highlighted open window that is currently being used. When you execute
a command, it affects only the active window.
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Windows lets you maintain many open windows simultaneously, but only one window is active
at any given time. When open windows overlap, Windows always displays the active window in
front of the inactive windows.
For example, if you have the MEMBERS form running concurrently with DataEase Help, you
can display them both on screen at the same time. However, when you click on the DataEase
Help window, your keystrokes only affect Help until you click on the MEMBERS form to make it
active again.

How to Use Scroll Bars
• Click on a scroll arrow (shown above) to move the document one vertical line or one
horizontal column in the indicated direction.
• Click anywhere between the scroll arrow and scroll box to move a full screen in the indicated
direction.
• Drag the scroll box to move the document a distance proportionate to the document's length
or width.
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DataEase Menus
The Menu Bar lists all DataEase menus. Each word on the Menu Bar is a menu title. Each
menu is a list of options. When you open a menu and select an option, DataEase performs a
function. DataEase uses standard Windows conventions in its menus to convey status
information about menu options. These conventions are shown in the figure below, and an
explanation of each follows.

Triangle indicates that DataEase displays a submenu (called a cascade menu) when you
select the option.
Ellipsis (...) indicates that DataEase displays a dialog when you select the option. Dialogs are
discussed later in this chapter.
Check Mark indicates an option is on (or active). This convention is used only with options that
toggle between on and off settings. Click on an active option to deactivate it.
Keyboard Shortcut displays the keyboard combination for the menu option.
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DataEase Toolbars
The DataEase Toolbar lets you quickly access the most commonly used menu options in each
mode without requiring you to open the appropriate pull-down menu. To execute the menu
option, you just click on the corresponding Toolbar button.
DataEase has two Toolbars, displayed in User View and Designer View respectively.
User View Toolbar provides instant access to User View options located on the Edit, View,
Query, and Goto menus.
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Designer View Toolbar provides instant access to Designer View options located on the
Objects menu.

The DataEase Help file contains a button-by button description of the Toolbars.
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DataEase Dialogs
When you select a menu option followed by an ellipsis (...), DataEase opens a special type of
window called a dialog. A dialog requests more information that tells DataEase how to
execute the selected menu option.
DataEase highlights the active element in a dialog with a dotted outline. To switch from one
group of choices to another, simply click on it. If you use the keyboard, press Tab to move the
outline from choice to choice (press Shift + Tab to move the outline in reverse order). Each
dialog choice has a graphic element that controls what kind of information it accepts (e.g., any
text or numbers only). Each dialog control is shown in the figure below and explained in the
table on the next page.
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DataEase Dialog Controls
The table below summarizes how to use each control that appears in a DataEase dialog.
Control

Lets you...

Using a Mouse

Using the Keyboard

Text Box

Fill with any text. Your text
overwrites what is already
there.

1. Click on a text box.

1. Tab to the text box.

2. Begin typing when the
cursor appears.

2. Begin typing when the
cursor appears.

Fill a text box with a
selection from a defined list
of options.

1. Scroll the desired option
into view.

1. Press the arrow keys.
until the desired option is
highlighted, then press
Enter.

Fill a text box with a
selection from the list of
choices that are displayed
when you click on the dropdown arrow next to the text
box.

1. Click the drop-down
arrow to display
alternative options.

3. Release the mouse
button to select.

3. Press Enter to select.

Radio
Button

Select only one option from
a list of alternatives.

Click the desired button to
select it.

1. Press the arrow keys to
move the cursor to your
choice, then press the
Spacebar.

Check Box

Select one or more options
from a list of alternatives.

Select and unselect in the same way as radio buttons.

List Box

Drop-Down
List Box
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2. Click on it.

2. Drag the mouse until your
choice is highlighted.

1. Press Alt + ì to open the
list.
2. Press the arrow keys until
your choice is
highlighted.
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Alert Messages
DataEase uses four icons to indicate the importance of alert messages (see table below).

Alert Message Icons
Icon

Meaning
Indicates a critical message.
Indicates a warning.
Indicates a warning that requires your input.
Accompanies an informational message.
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Chapter 2 : Record Entry
Creating, Modifying, and Deleting Records
See Chapter 4 of the User Guide for more information about creating, modifying, and deleting
records.
This chapter provides general information on using DataEase forms, including:
•

Viewing records

•

Creating records

•

Modifying records

•

Deleting Records

•

Using a form with a Custom Tab Order

•

Using a form with buttons

•

Using DataEase in a multi-user environment

Record entry is the most frequent operation performed in User View. In fact, most people who
use a DataEase application spend the majority of their time entering new data and updating
existing records.
As more data is added to a database each day by entering new records in DataEase record
entry forms, an organization can immediately use this data to find specific records, answer
business questions (called queries), create custom reports, process transactions, and take
advantage of the easy access and strong analytical capabilities that DataEase provides.
The basic concepts that affect record entry operations are briefly summarized on the next two
pages and explained in detail on the following pages.

Overview of Record Entry Procedures
Topic

Summary

Opening a
Record Entry
Form

Choose File>>Open or double-click on the name of the form in the
Application Catalog.

Entering a New
Record

When you display a form in User View, DataEase automatically positions
the cursor in the first field where you can enter data. To enter a new record,
just type values in the blank fields and press F2 SAVE AS NEW RECORD.

Moving the
Cursor

When you fill every character in a field, DataEase automatically moves the
cursor into the next field. If the cursor does not move automatically, press
Tab (or use the mouse pointer) to move the insertion point into the next field
on the form. (DataEase does not automatically move through a derived or
lookup field unless it is defined as Virtual.)

Using a Custom
Tab Order

Normally, the cursor moves from the top left to the bottom right field on the
form. However, if the application designer has assigned a Custom Tab
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Order, the cursor moves from field to field in an assigned sequence.
Buttons and graphics that execute actions are included in the form's tab
order.
Viewing
Records

Records in a Native DataEase form are stored in the order they are entered.
Press F3 VIEW or choose Goto>>Next Record to view the record following
the one you are currently viewing. Press Shift + F3 VIEW BACK or choose
Goto>>Previous Record to view the record preceding the one you are
currently viewing. You can also click the Previous Record and Next Record
buttons on the Toolbar.

Searching for
Records

Choose Query>>Select Records or click the QBF (Query By Form) button
on the Toolbar to find a specific record. Enter your search criteria (sample
values) into one or more fields on the form to tell DataEase which records
you're looking for. Press F3 NEXT RECORD or choose Goto>>Next
Record. DataEase displays the first record that contains the specified field
value(s). Choose View>>Table to display all matching records.

Accessing a
Record in a
Related Form

Press F10 RELATED FORM or choose Goto>>Related Form to display a
list of all the record entry forms related to the form you are currently
viewing. Double-click on the name of the related form to open it. If the
cursor occupies a Match field when you press F10 RELATED FORM,
DataEase displays the first matching record in the related form. Press Ctrl +
D RETURN DATA to return the data in each Match field to the original
record and derive any fields based on those values. Press Shift+F10
RETURN TO to return to the original record without retrieving data.

Using Forms
That Include
Buttons

The application designer can insert any number of buttons on a form and
assign each a predefined action that is automatically executed when you
tab onto the button and press Enter, or click on the button. A button can
perform a wide variety of actions, such as opening another form, saving
data, or running a video presentation.

Saving a Record

Type a valid value into each field in the record entry form. Press F2 SAVE
AS NEW RECORD or choose Edit>>Save As New Record to save all the
data entered as a new record in the form.

Modifying a
Record

Move the cursor into a field and type any changes you wish to make to the
value. When you complete all your changes, press F8 SAVE or choose
Edit>>Save to overwrite the existing record with the new information.

Deleting a
Record

Press F7 DELETE or choose Edit>>Delete Record to delete the record the
cursor is located in. If the record is stored in a DataEase Multiform,
DataEase asks you how to delete the related Subform records.

Printing
Records

Press Ctrl + P PRINT or choose File>>Print to print the record(s) in the
document that is currently active.
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What Is a Record Entry Form?
A DataEase record entry form is a document that contains at least one data entry field. A form
can also contain text, buttons, image data, and background graphics. A form is used to enter,
find, display, and filter the data stored in a database table.

Form Appearance
The appearance of a record entry form is defined by the application designer in Designer View.
Because each form is designed for a specific purpose, the text, fields, and other elements vary
from one form to another (just as an Employment Application form looks different from a Motor
Vehicle Registration form).
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System versus Custom Forms
System Forms are predefined forms that store the information DataEase needs to manage an
application. DataEase uses three predefined System forms:
• Users contain information about the names, passwords, and security levels of users.
• Relationships contain information about how the application's database tables are related.
• Custom Functions contain information about which Custom-Defined Functions the
application can use.
• Custom Forms display the data managed by the application. Custom forms are normally
created by the application designer.
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Multiforms
A Multiform is a Custom form that combines two or more related forms so that they appear on
the screen at the same time. An application designer may design a Multiform without clearly
defined boundary lines so it looks and behaves like a single form.
A Multiform lets you view, enter, modify, and delete data from two or more related forms
simultaneously. This property makes it easier for you to enter and search for data in a complex
database.
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Opening a Record Entry Form
Before you can enter, view, modify, or delete records, you must open a record entry form in
User View. DataEase provides two ways to open a form:
• If the Application Catalog is open, double-click on the name of the document to open it.
DataEase lists the names of the documents in alphabetical order and groups the documents
according to document type (i.e., form, report, menu).
• Choose File>>Open to display the Open a Document dialog.

Form versus Table View
See USER GUIDE Chapter 5 for information on how to switch between Form and Table View.
When you open a record entry form in User View, DataEase lets you display the form in Form
View or Table View.
Form View displays one record at a time. In Form View, the form displays all the text, fields,
graphics, and buttons the application designer defined.
Table View displays multiple records on screen at one time. Each column in the table is a
field, and each row in the table is a record. In Table View, the form does not display buttons,
pictures, and/or graphics.
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How Records Are Arranged
When you view records in a DataEase record entry form, the order in which they are displayed
depends on whether the database table is stored as a Native database or as an SQL
database.
Records in a form based on a DataEase Native table are arranged in the order they are
entered in the table (the most recently added record is always the last record in the table).

Note: Records in a form based on an SQL table are arranged in ascending order by the values
in the Unique key (a single value derived by concatenating the values in all the Unique fields
on the form).

Customizing Table View to Facilitate Record Entry
DataEase lets you customize Table View by changing the size of the columns and rows in a
table or by moving an entire column to a new location.
You can customize the appearance of Table View in several ways. To fit more information in
the document window, you can decrease the width of the columns or the height of the rows.
You can also move the columns that are most important into view.
For example, if you need to contact members by phone, you can move the TELEPHONE
column in the MEMBERS form to the left side of the table. This adjustment makes it
unnecessary for you to scroll the table to view the TELEPHONE column.
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The changes you make to the columns and rows in Table View are temporary. These changes
do not affect the position or size of the fields in Form View, and DataEase discards these
changes when you close the document. The next time you open the form in Table View,
DataEase displays the columns and rows in their original size and position.
To permanently change the column order, you can set a Custom Tab Order in Designer View.

How to Change the Width of a Column in Table View
1. To increase or decrease a column's width, click the right column border in the column
header.
2. When DataEase displays the double-sided arrow, drag the border to the right to increase the
width or to the left to decrease the width.
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3. Release the mouse button. The other columns shift to the right or left, but retain their original
width.

Note: When you increase or decrease a column's width, the text in all columns retains its size
and position. However, if you decrease a column's width, some text in that column may be
hidden by the right column border.

How to Change the Height of All Rows in Table View
1. To increase or decrease the height of all rows, click the top or bottom row border of any row
in the Row# column. DataEase displays the double-sided arrow.
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2. To increase the height of all rows, drag the bottom row border down or the top row border up
the desired distance. To decrease the height of all rows, drag the top border down or drag
the bottom row border up the desired distance.
3. Release the mouse button. The text in the rows retains its size and position. If you decrease
the height, some text may be hidden from view by the bottom row border.

How to Move a Column in Table View
1. To select the column, click in the center of the column header and hold down the mouse
button. DataEase highlights the column.
2. Drag the selected column to its new position.
3. Release the mouse button. DataEase shifts the other columns to the right or left to
accommodate the repositioned column.
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Creating a New Record
See DESIGNER GUIDE Chapter 6 for more information on defining field-level security.
When you display a form in User View, DataEase automatically positions the cursor in the first
field where you can enter data. To enter a new record, just type values in the blank fields on
the form and press F2 SAVE AS NEW RECORD.

How Document Security Affects Record Entry
When an application designer creates a record entry form in Designer View, he or she uses
the Document Security dialog to assign the minimum security level required to perform the
following record entry operations:
• Viewing Records
• Entering Records
• Modifying Existing Records
• Deleting Records
If your security level is lower than the minimum level specified for the attempted action in the
Document Properties dialog, DataEase displays a Security Violation message and prohibits
you from performing the action.
To perform a record entry operation on the data in an SQL table, you must have the required
VIEW, INSERT, MODIFY, and/or DELETE permission on the SQL engine, in addition to the
minimum security level required by DataEase.
Note: If your DataEase security level is insufficient, or you lack the required SQL permission
to perform your assigned job responsibilities, ask the system/database administrator for
assistance.

How a Multi-User Environment Affects Record Entry
See USER GUIDE Chapter 8 for more information on multi-user locking.
In a multi-user environment, two or more users can view the same record(s) simultaneously.
However, when a user makes a change to either the document's design or the data, DataEase
automatically locks the affected part of an application for the exclusive use of that user. The
table below summarizes the locking rules DataEase follows in a multi-user environment.

Data Locking in a Multi-User Environment
DataEase Locks...

When...

All the Records in a Form

Any user tries to change any aspect of the form in
Designer View.

An Individual Record

Any user tries to save changes to the data in the record.
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Resource Conflict Messages
In a multi-user environment, you may occasionally try to access a record that is not available
because someone else has exclusive use of that record. When this event occurs, DataEase
displays a Resource Conflict message similar to the following:
The resource you selected is currently in use:
By user: User Name
Machine: Computername
Waiting for form Formname definition
n attempts to access resource, Press ESC to abort
This message will vary slightly, depending on the type of resource DataEase is trying to
access.
DataEase continues trying to access the record n times until the resource becomes available.
The n is incremented every five seconds, indicating how many attempts have been made. As
soon as the resource becomes available, the message disappears and DataEase resumes
processing.
If you press Esc while this message is displayed, DataEase aborts the transaction within a few
seconds. In some situations, however, you cannot abort a transaction without jeopardizing
data integrity. In these situations, DataEase does not let you abort the transaction, and the
message Press ESC to abort does not appear.
Note: Some networks do not let DataEase display the name of the user and the computer
using the requested resource. The system administrator may also choose not to display this
information. Therefore, depending on your system configuration, the User Name and
Computername may not appear in the Resource Conflict message.
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How Field Type Affects Record Entry
In Designer View, DataEase lets the application designer create different types of fields when
designing a record entry form: Text, Number, Numeric String, Currency, Date, Time, Choice
List, Yes/No, Sequenced ID, and Memo.
When a form is displayed in User View, DataEase allows only certain characters to be entered
in a field, depending on the Field Type. For example, the ROOMS field on the CLUBS form is
defined as a Number field. If you try to enter an alphabetical letter in this field, DataEase
displays an error message and does not let you save the record.
This restriction prevents you from saving incorrect data, which impairs your data's integrity.
The restrictions that govern what type of data can be entered in each Field Type are
summarized in the table below.

Summary of Valid Data for Field Types
Field

Type of

Type

Data Entered

Text

Alphanumeric and other
keyboard characters,
including ANSI
characters.

Sample Field
Data/Format

Restrictions During

David St. Hubbins

Do not enter wild cards

123 Maple Lane

(*, ?, and ~)
as part of a record.

Numeric
String

Numbers used for
identification only. Not
used for calculations.

No Format

Numbers without
formatting characters.

1234

Numbers with
formatting characters.

123-45-6789

Predefined
Format

DataEase fills incompletely
filled fields with leading zeros.

2345678

(123)456-7890
12345-6789

Number

Numbers that denote a
quantity. Used for
calculations.

Integer

Numbers with no
decimal point.

12,345

Numbers with a fixed
number of digits to the
right of the decimal
point.

123.456

Fixed
Point
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Social Security Number
Telephone Number Custom
Zip Code

Type the minus sign (-) to
make the number negative.

234

2.345

DataEase automatically
inserts commas after every
third digit.
DataEase automatically
inserts commas after every
third digit.
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Floating
Point

Numbers with a userentered decimal.

12.3456

Currency

Monetary values with
two digits to the right of
the decimal point.

1,234.56

Date values.

06/20/98

Date

2345.6

23.45

20/06/92
92/06/20
Extended
Date

Date Values

16/09/1999
03/26/2000

DataEase does not
automatically insert commas.
DataEase automatically
inserts commas after every
third digit.
Date values contain numbers.
You must enter the leading
zeros, but you do not need to
enter the slashes.
Date format which uses 4digits
to show the Year.

Time

Time values.

10:57:36

Time values contain numbers.

Choice List

Values chosen from a
list of up to 99
predefined choices.

1: Single

You can only enter choices
that are listed for the field.

Yes or No values only.

1: Yes

Yes/No

2: Married
3: Divorced

You can only enter Yes or No.

2: No
Sequenced
ID

Automatically
incremented value (new
field value = field value
in the previous record +
1).

001Y
001Z
002A

Sequenced ID fields are
usually Prevent Data-entry
and do not usually need the
unique flag.

Note: You must use the Windows Control Panel to change the default Date, Number, or
Currency field format to another national format throughout your application.
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How Field Characteristics Affect Record Entry
In addition to specifying a Field Type, DataEase lets the application designer assign special
Field Characteristics to a field when designing a record entry form.
When a form is displayed in User View, the Field Characteristics assigned to a field further
restrict what kind of data you can enter in the field. For example, the CLUB ID field on the
CLUBS form is assigned the Prevent Data-entry Field Characteristic, which prevents the
cursor from entering this field. You cannot manually enter data in the field. The CLUB ID field
is automatically filled by DataEase using a Derivation formula which derives a sequenced
Numeric value (e.g., 00001, 00002, etc.).
The rules that govern how Field Characteristics affect record entry operations are summarized
in the table below.

Effect of Field Characteristics on Record Entry
Field
Characteristic

Purpose

Effect on Record Entry

Required

Prevents you from saving
the current record until
you enter data in the
field.

You must enter values in all Required fields
on the form before you can save the record.

Unique

Prevents duplicate
records (two records with
exact matching field
values).

If the form has more than one Unique field,
DataEase combines the Unique field values
into a Unique key. In this case, the same
Unique field value may be saved in more than
one record, as long as the combination (key)
is unique.

Validation
Formula

Allows only values that
fall within the acceptable
range.

Displays an error message if the value you
enter is outside the predefined range.

Derivation
Formula

Automatically enters a
value when the form is
displayed.

You can modify any derived value by typing a
new value in the field (if the field is not
Prevent Data-entry).

Default

Automatically fills in a
constant value if you
leave it blank.

Lookup

Automatically retrieves
the field value from a
related form or a system
value (e.g., current date).

(Upper/Lower
Limit)
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Calculation

Automatically derives a
value based on a
predefined formula.

A calculation can include the 58 DataEase
functions, relational operators, default and
lookup values, and system-provided values
for date, time, user name, user security level,
and computername.

Prevent Dataentry

Prevents you from
entering data in a field
with a Derivation
Formula.

You cannot move the cursor into a Prevent
Data-entry field (unless you are searching for
records using QBF).

Field Security

Prevents you from
viewing or entering field
values.

Your security level must be equal to or higher
than the minimum defined for the field.

View Security

Hides the field values.

Write Security

Prevents the cursor from
entering specific fields.
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Moving the Cursor in a Record Entry Form
While entering records in User View, many users find it easier to move the cursor using the
keyboard instead of the mouse. The keystrokes used to move the cursor in a record entry form
displayed in User View are summarized in the table below.

Cursor Movement in a Record Entry Form
Keystroke

Key Name

In Form View, moves to...

In Table View, moves to...

Up Arrow

Line above in a multiline field.
Otherwise, field or button above.

Record line above.

Down Arrow

Line below in a multiline field.
Otherwise, field or button below.

Record line below.

Left Arrow

Previous character.

Same.

Right Arrow

Next character.

Same.

Previous Form

Main form (or Previous
Subform).

First record on screen.

Next Form

Next Subform (or Main form).

Last record on screen.

Home

Home

Beginning of the current line
within a field.

Same.

Ctrl + Home

First Field

First field in current record. In a multiline field, moves to the first
character in the current field.

End

End

End of the current line within a field. In a multiline field, moves
to the last character in the current field.

Ctrl + End

Last Field

Last field in current record. If the cursor is already in the last
field, Ctrl + End moves the cursor to the last field in the parent
form.

PgUp

Previous page

Previous screen, same
horizontal position. In a multiline
field, scrolls to the previous
page in the current field.

N/A

Ctrl + PgUp

First page

One screen to the left.

Same.
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PgDn

Next page

First field on next page. In a
multiline field, scrolls to the next
page in the current field.

First field on next page.

Ctrl + PgDn

Last page

One screen to the right.

Same.

Backspace

Delete previous character.

Same.

Enter

Next field in tab order.

Same.

Tab

Next field in tab order.

Same.

Shift-Tab

Previous field in tab order.

Same.
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Moving the Cursor in a Record Entry Field
The keystrokes used to select, cut, copy, paste, and delete text within a field are summarized
in the table below.

Keys Used to Edit Data Values
Keystroke

Function

Ctrl + X

Cuts the selected text to the Clipboard.

Ctrl + C

Copies the selected text to the Clipboard.

Ctrl + V

Pastes the selected text from the Clipboard.

Backspace

Deletes the character to the left of the cursor or deletes the selected text.

Ctrl + Z, Esc

Restores the current field to the value saved to disk.

Delete

Deletes the character to the right of the cursor or deletes the selected text.

Shift +

Selects/deselects one character to the right.

Shift +

Selects/deselects one character to the left.

Shift +

In a multiline field, selects/deselects the line of text from the cursor position to
the same position in the line above it.

Shift +

In a multiline field, selects/deselects the line of text from the cursor position to
the same position in the line below it.

Shift + PgUp

Selects/deselects all text to the top of the field/window.

Shift + PgDn

Selects/deselects all text to the bottom of the field/window.

Shift + Home

Selects/deselects text to the start of the line.

Shift + End

Selects/deselects text to the end of the line.

Ctrl + Shift +

Selects/deselects the next word.

Ctrl + Shift +

Selects/deselects the previous word.

Ctrl + Shift + Home

Selects/deselects text to the beginning of the field.

Ctrl + Shift + End

Selects/deselects text to the end of the field.
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Using a Custom Tab Order
See DESIGNER GUIDE Chapter 4 for more information on designing a Custom Tab Order.
When you press Tab during record entry, the cursor moves to the next field, button, or graphic
image. By default, the cursor starts at the upper left corner of the form and then moves from
left to right and top to bottom towards the lower right corner. The default tab order is the same
in Form View and Table View. Press Shift + Tab to move in reverse order.

To make record entry easier, the application designer may assign a Custom Tab Order to a
form. The Custom Tab Order also determines the default order of columns in Table View. One
advantage of a Custom Tab Order is that it can let you create a more natural flow to entering
records when the default tab order does not.
The Custom Tab Order is ignored when you use a mouse. Click the field, button, or image you
want to make active.
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Viewing Records
The table below summarizes the Toolbar buttons, menu options, and function keys you can
use to browse through records in a form.

Tools for Viewing Records
Function

Icon(s)

In Form View...

In Table View...

View First Record

Choose Goto>>First Record.

Choose Goto>>First Record or
press Ctrl + Home.

View Next Record

Choose Goto>>Next Record or
press F3 NEXT RECORD.

Press

View Previous Record

Choose Goto>>Previous
Record or press Shift + F3
PREVIOUS RECORD.

Press

View Last Record

Choose Goto>>Last Record.

Choose Goto>>Last Record or
press Ctrl + End.

Toggle Between
Table/Form View

Choose View>>Table.

Choose View>>Form.

Viewing Records in a Report
When a report is displayed for QBF or Browsing, you can navigate through the report using the
keys, menu options, and Toolbar buttons that you use to navigate through records in a form.
When a report is displayed for Browsing, you can choose Goto>>Related Form to display
forms related to the current report.

When a report is printed to a window, you can also use the Previous Data Page button to
display the previous page of records.

When a report is printed to a window, you can also use the Next Data Page button to display
the next page of records.
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Searching for Records
DataEase supports two different ways to search for records: Query By Form (QBF), which is
available whenever a form or report document is displayed in User View, and Query By Model
(QBM), which is available in both User View and Designer View.
Query By Form locates all the records that contain the sample value(s) you enter in one or
more fields on the document. The table on the next page summarizes the basic techniques
you can use to find specific records, view all the records found by DataEase in response to the
search criteria you enter, open a related form, and retrieve data from a related record.
Note: Fields that are frequently used to find a particular record should be indexed, since
indexing significantly improves the speed of the search.

Searching for Records
To...

Do the Following...

Access QBF

Choose Query>>Select Records, press Alt + F5, or click on the QBF Toolbar
button and enter search criteria directly on the form.

Enter Search Criteria

Choose Query>>Selection Criteria and enter a value that defines the record(s)
you want to see.

Perform a Wild Card
Search

Use wild card characters to find records when you are not sure of the exact
value. ? finds a single unknown character. * finds any number of unknown
characters. ~ finds values that sound like the value you are searching for. For
example, enter CT in the STATE field to see all records with STATE = CT. Use
wild card characters to find records when you are not sure of the exact value.
For example, enter C* in the STATE field to see all records with a state that
begins with C (CA, CO, etc.).

Perform a Soundex
Search

Enter the Soundex character ~ followed by the value that sounds like the value
in the record(s) you are searching for. For example, to find a value that sounds
like Bob, type ~BB. DataEase displays matching values (e.g., bab, beb, Bob,
bib).

Display Table View of
Matching Records

Choose Query>>Select Records. Enter the selection criteria. Use * and ? to
broaden the search if desired. Choose View>>Table.

View First Matching
Record

Choose Query>>Select Records. Enter the selection criteria. Use * and ? to
broaden the search if desired. Choose Goto>>Next Record or press F3.

View Next Matching
Record

Press F3 to display more matching records.

Display a Related Form

Press F10 and select the relationship to view. Perform the desired record entry
functions. Press Shift + F10 to return to the original form.

Look up Related Fields

Press Ctrl + F10 when the cursor is in the relationship Match field. DataEase
displays a table view of related field values. Highlight the value you want to
return to the Primary form and press Enter.
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Time-Saving Tips for Entering a New Record
The table below summarizes several shortcuts to help speed up record entry.

Record Entry Quick Reference
Operation

How to Perform Operation

Entering Records
Enter a New Record

Fill in the form and press F2 SAVE AS NEW RECORD or choose Edit>>Save
As New Record.

Use an Existing Record
to Create a New Record

After you enter a record, don't clear the screen. Simply type over the values
that need to be changed and press F2 SAVE AS NEW RECORD or choose
Edit>>Save As New Record.

Modify a Record

Make changes to the record on the screen and press F8 SAVE or choose
Edit>>Save.

Delete a Record

Press F7 DELETE or choose Edit>>Delete Record. Click OK to verify.

Entering Data into a Field
Fill in a Field

Type data in the field. Press Tab if the data does not completely fill
the field or if Automatic Tab is turned off in Document Properties.

Edit the Value in a Field

Use Backspace, Ins, Del, and Edit>>Clear Field (or highlight the
field value and press Del).

Clear a Single Field

Highlight the field and press F6 or Del or choose Edit>>Clear Field.

Clear the Screen

Press F5 FORM CLEAR or click on the Form Clear button on the
Toolbar.

Enter a Number Value

Type the digits. If the number is negative, type a minus sign before
the number.

Enter an Integer Value

Type the digits.

Enter a Fixed
Point/Dollar Value

Type the digits to the left of the decimal. If necessary, type the digits
to the right.

Enter a Floating Point
Value

Type the digits to the left of the decimal. If necessary, type the
decimal point and the digits to the right.

Enter a Numeric String
Value

Type the digits only. DataEase automatically enters leading zeros.

Enter a Date/Time Value

Type the digits only (do not type slashes, colons, or other formatting
characters).

Enter a Choice Value

Click on the drop-down arrow icon to open the list of choices. Click
on the choice value you want to enter in the field.
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Enter a Derived Value

Press Enter when the cursor is in the derived field. A derived field
value is automatically entered.

Note: When you enter, modify, or delete records in a form based on an SQL database table,
DataEase transparently inserts, updates, or deletes data in the SQL table.
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Using Function Keys in Record Entry
While entering records in User View, many users prefer to press a function key to perform a
command rather than select a menu option using the mouse. The function keys used during
record entry are summarized in the table below.

Function Keys in Record Entry
Keystroke

Key Name

Form View

F1

HELP

Display the DataEase Help
System.

Shift + F1

CONTEXTSENSITIVE
HELP

Display a pointer used to access a context-sensitive
Help topic from the DataEase Help System. (Press
Esc to abort.)

Alt + F1

USER HELP

Display the document- and field-level Help that the
application designer defined.

F2

SAVE AS

Save the record on the screen.

Save
changes/additions
to table.

NEW RECORD

Table View

F3

VIEW NEXT
RECORD

Display next consecutive
record or view queried records
when using QBF.

Display next
consecutive
record.

Shift + F3

VIEW
PREVIOUS
RECORD

Display previous consecutive
record or view queried records
when using QBF.

Display previous
consecutive
record.

F4

DESIGNER
VIEW

Change to Designer View.

Same.

Ctrl + Z, Esc

UNDO

Undo typing in current field (before saving to disk).

F5

CLEAR FORM

Clear the form on the screen.

Alt + F5

SELECT
RECORDS

Accept search criteria (turn off derivations and
Prevent Data-entry attributes).

F7

DELETE

Delete current record.

Same.

F8

SAVE

Modify current record.

Save changes
made to the table.

F9

QBM

Access Query By Model (QBM) to create a report.

Ctrl + P

PRINT

Access the Print dialog to print the current data.
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F10

RELATED
FORM

Display related form.

Same.

Ctrl + F10

LOOKUP

Lookup related value.

Same.

Ctrl + D

RETURN
DATA

Return Match field data to the Primary form.
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Using Relationships in Record Entry
See DESIGNER GUIDE Chapters 2, 7 and 8 for information on defining a relationship.
When the application designer creates the record entry forms in your application, the designer
can also define relationships between the underlying database tables. To create a relationship
between two database tables, at least one column must be duplicated in each table. These key
columns (called Match fields) hold exact matching values in both tables.
For example, the relationship between MEMBERS and FAMILY MEMBERS is based on the
existence of the MEMBER ID column in both of the associated database tables.

Viewing Related Forms
Once a relationship is defined between two tables, you can access the data in both tables from
a record entry form based on either table. For example, when you are viewing the Buccaneer's
Creek record in the CLUBS form, pressing F10 RELATED FORM lets you view all the related
PRICES records. These records show the different prices charged for a vacation at
Buccaneer's Creek based on the departure zone and season.
When you press F10 to view a related form DataEase displays a dialog that lets you choose
the document you want to view.

Entering Data from Related Forms
In addition to providing a quick way to view the records in a related form, DataEase can quickly
retrieve the data in each Match field and automatically copy the data into the record you are
currently filling in. The automatic data-entry features explained below can greatly speed up
record entry operations.

Ctrl + F10 LOOKUP
See DESIGNER GUIDE Chapters 2 and 8 for information about defining and using
relationships.
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When you are entering data in a record, if you place the cursor in a Match field and press Ctrl
+ F10, DataEase displays a pop-up table of the records in a related form. For example, if you
place the cursor in the CLUB NAME field in the RESERVATIONS form and press Ctrl + F10,
DataEase displays a pop-up table of the records in the CLUBS form.

You can use the Scroll Bars to browse through the related records. When you double-click on
a record in the list, DataEase retrieves all the Match field data from that record and
automatically enters it into the record you are currently filling in. In the above example, if you
click on the Buccaneer's Creek record in the CLUBS form, DataEase automatically copies the
CLUB NAME and the CLUB ID values into the current record in the RESERVATIONS form.
If the form you are looking up has many records, you can reduce the number of related records
that appear by entering search criteria in the Match field and then pressing Ctrl + F10.

Ctrl + D RETURN DATA
When you are entering data in a record, if you press F10 to display a related form, you can
enter search criteria in one or more fields to find a specific related record. The related form can
be: (1) the form that defines a table, or (2) a form that uses a table and pre-filters that data.
When you find the correct record, press Ctrl + D RETURN DATA to return to the original form
and insert all Match field values into the current record.
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For example, if you are filling in a RESERVATIONS record, press F10 to open the MEMBERS
form. Use QBF to find the record for the member making the reservation. When you find the
member's record, press Ctrl+D to return to the RESERVATIONS form and automatically enter
the member's name and address in the current record.
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Using Forms That Include Custom Buttons
See DESIGNER GUIDE Chapter 6 for information on assigning actions to buttons and
images.
A form can contain one or more custom buttons. A button is a rectangular object that performs
a predefined action when you click on it. The figure below shows a form that has several
buttons.

Button and Image Actions
See DESIGNER GUIDE Chapter 6 for a complete list of button actions.
When creating a button or image, the application designer can assign it an action. Some
actions that DataEase allows are summarized in the table below.
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Button Actions
Button

Equivalent Option/

Action

Keystroke

When You Click on the Button,
DataEase...

New Record

File>>New Record

Displays a blank record.

F5 CLEAR FORM
Save Record

Edit>>Save As New Record

Saves the current record.

F2 SAVE AS NEW RECORD
Delete Record

Edit>>Delete Record

Deletes the current record.

F7 DELETE
First Record

Goto>>First Record

Displays the first record.

Next Record

Goto>>Next Record

Displays the next record.

F3 NEXT RECORD
Previous Record

Goto>>Previous Record

Displays the previous record.

Shift + F3 PREVIOUS RECORD
Last Record

Goto>>Last Record

Displays the last record.

Selection Filter

Query>>Select Records

Lets you enter selection criteria.

Alt + F5
Clear Selection
Filter

Query>>Select Records

Open Document

File>>Open Ctrl + O

Displays the Open Document
dialog.

Form Open Related

Goto>>Related Form

Display a list of related forms.

Clears selection criteria.

Alt + F5 and F5 CLEAR FORM

F10 RELATED FORM
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Saving a Record
When you finish entering data in all the fields on a record, choose Edit>>Save As New
Record or press F2 SAVE AS NEW RECORD to save the information to disk. DataEase saves
the entered data as a new record if all of the following conditions are met:
• A value has been entered in each Required field.
• The Unique field values are not duplicated in any other record on the same form.
• Your security level is equal to or higher than the minimum security level required to enter
records in the document.
The keystrokes used to save records and their effects in various DataEase formats are
summarized in the table at the end of this chapter.
Note: To save a new record in an SQL table, you must have INSERT permission on the SQL
engine as well as the minimum security level required by DataEase.
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Modifying a Record
To change the data in an existing record, move the cursor into each field and type the new
information over the existing value. When you finish modifying the record, choose Edit>>Save,
press F8 SAVE, or click on the Save button on the Toolbar to save the new information to disk.
DataEase saves the modified data as the same record (DataEase does not create a new
record) providing the following conditions are met:
• A value has been entered in each Required field.
• The Unique field values are not duplicated in any other record on the same form.
• Your security level is higher than the minimum security level required to modify records in
the document.
The keystrokes used to modify records and their effects in various DataEase formats are
summarized in the table at the end of this chapter.
Note: To modify a record in an SQL table, you must have UPDATE permission on the SQL
engine as well as the minimum security level required by DataEase.
Note: When you modify records in Table View, DataEase inserts an asterisk in the first
column to denote the change. When you press F8 SAVE, DataEase writes the change to disk
and removes the asterisk.
If you press F8 SAVE while you are viewing a new record, DataEase saves it as if you chose
F2 SAVE AS NEW RECORD.
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Deleting a Record
To permanently delete a record from a form, choose Edit>>Delete Record or press F7
DELETE. DataEase displays a dialog and asks you to confirm the deletion. Click OK or press
Enter to delete the record. Click Cancel or press Esc to abandon the deletion.
When you click OK to confirm the deletion, DataEase deletes the record providing your
security level is equal to or higher than the minimum security level required to delete records in
the document.
The keystrokes used to delete records and their effects in various DataEase formats are
summarized in the table at the end of this chapter.
Note: To delete a record from an SQL table, you must have DELETE permission on the SQL
engine as well as the minimum security level required by DataEase.
Note: When you delete a record in Table View by pressing F7 DELETE, DataEase inserts a D
in the first column to denote the deletion. When you press F8 SAVE, DataEase writes the
change to disk and removes the D.
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Restoring Deleted Records
To recover a record in a DataEase Native table that has been marked deleted but has not yet
been erased from disk, move the cursor into any field in the record and choose Edit>>Restore
Record or press Ctrl+F5 RESTORE RECORD.

Saving, Modifying, and Deleting Records
In...

Press F2 SAVE AS NEW
RECORD to...

Press F8

Press F7

SAVE to...

DELETE to...

Form View

Save the record that is
currently visible on the
screen.

Update the record that is
currently visible on the
screen with the data
changes you have entered.

Delete the record that is
currently visible on the
screen.

Table View

Save all the records that
you have entered since
you last saved to disk.

Save all the records that
you have modified since
you last saved to disk.

Erase all the records that
you have deleted since
you last saved to disk.

A Multiform

Save the current Main
form record and each
Subform record entered
since you last saved to
disk.

Save all the changes made
to the Main form and
Subform records since you
last saved to disk.

Display a dialog that asks
you to specify exactly
what you want to delete
(Main form record only,
Subform record only, or
both). The choices
DataEase displays in this
dialog vary depending on
which referential integrity
option the application
developer assigned to the
document.

A Native Table

Add the record at the end
of the table.

Modify a record in a
DataEase Native table. The
record is maintained in the
same position in the table.

Remove the record from
the screen. The record is
not actually erased from
the disk file until you
reorganize the form.

An SQL Table

Insert the record into a
position in the table based
on the value of its Unique
key. The previously
existing records are
automatically arranged to
accommodate the new
entry.

Modify a record in an SQL
table. The record is
maintained in the same
position unless the
modification changes the
value of the record's
Unique key.

Erase the record from an
SQL table. Records
deleted from an SQL table
cannot be restored.
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Chapter 3 : The File Menu
Managing Documents and Importing and Exporting Data
See the User Guide Introduction for information on the File menu that is displayed when you
first start DataEase.
The options on the File menu are used to create, open, close, and print documents, and import
and export data. Options toward the bottom of the menu let you switch to Designer View, close
the current application, and end the session.
Each menu option is summarized in the table below and explained in detail on the following
pages.

Summary of File Menu Options
Menu
Option

Keyboard
Equivalent

Menu Option Is Used to...

New

Alt + F, N Ctrl + N

Create a new document. DataEase automatically switches to
Designer View.

Open

Alt + F, O Ctrl + O

Open an existing document.

Close

Alt + F, C Ctrl + F4

Close the active document.

Delete

Alt + F, D

Delete a document and database table from the current
application.

Print

Alt + F, P Ctrl + P

Print data. This option is enabled only if a document is open.

Print
Setup

Alt + F, R

Select and configure the default printer. This option is enabled
only if a document is open.

Import

Alt + F, I

Import data into any database table.

Export

Alt + F, E

Export data from a DataEase application to another DataEase
(DOS or Windows) application or another software program.

Designer
View

Alt + F, V F4

Display the active document in Designer View.

Close
Applicatio
n

Alt + F, L

Close the current application.

Exit

Alt + F, X
Alt + F4

End the DataEase session.
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Creating a New Document
See DESIGNER GUIDE Chapter 1 for information on document types.
See DESIGNER GUIDE Chapter 6 for information on creating Document objects.

When you choose File>>New, DataEase displays a cascade menu that lets you choose the
type of document you want to create: a form, report, menu, or procedure.

After you choose the document type on the menu, DataEase displays your choice in the New
Document dialog. This dialog lets you choose a Database Table and a Style Sheet for the
document.
After you choose the document type, DataEase switches to Designer View. See the
Designer's Guide for more information on creating new documents.
Note: You must have the minimum security level required to create a new document.
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Storing DataEase Documents
Whenever you save a new document, DataEase creates at least one DOS file. DataEase
stores the files it creates in the directory of the current application. For example, all the files
associated with Club ParaDEASE are located in the C:\DFW\CLUB directory.
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Opening a Document
See USER GUIDE Chapter 7 for information on Document Properties.
When you choose File>>Open, DataEase displays the Open a Document dialog shown below.
This dialog is used to open a document in the current application.

Open a Document Dialog Options
Documents displays all the documents in the current application.
Open in Designer View tells DataEase to immediately display the document in Designer
View. Click on a document to select it.
By default, all documents open in User View. You can have up to ten documents open at once,
including document icons. When you try to open an eleventh document, DataEase displays an
error message. Click OK and close any documents you aren't using.
Note: The initial size, location, and action (e.g., display a New Record) for a document
window can be set with Document>>Properties.
When you close a document, it is cleared from your system's memory. If you are running out of
memory, close any documents you aren't using.
To open a document, you must have a DataEase security level equal to or greater than the
minimum security level defined to view that document. The minimum security level is defined
on the Document Security dialog in Designer View.
Note: To open a document that accesses an SQL table, your identity must also be recognized
by the SQL engine. If you are not recognized by DataEase and the SQL engine, DataEase
displays an error dialog box. The dialog box will list the SQL engine type, and the name of the
database server and the specific database relating to the error.
The error dialog asks you to supply two parameters – Name and Password.
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Login Failure Dialog Options
Name lets you enter a User Name that is recognized by DataEase and that is a valid Login
Name for the SQL engine being accessed.
Password lets you enter a Password, if one is required, that is recognized by the database
server being accessed.
If you receive this dialog, ask your system administrator for a valid User Name and Password
combination.

How a Report Appears in User View
See USER GUIDE Chapter 7 for information on entering QBF selection criteria.
When you open a report in User View, its appearance may vary depending on how the
application designer assigns its default Document Properties. A report can be assigned to
open in one of three ways:
• QBF lets you enter selection criteria to filter the data displayed in the report.
• Live (Browse) displays the report data in an outline-like format that includes space for four
records from each group, along with group totals.
• Print sends all the data to a window on the screen, a printer, or a disk file, depending on the
default Print Destination. Each group level in the report dynamically expands to
accommodate all the requested data.
Note: To switch a report from Live to QBF, choose Query>>Select Records.
Once you view the report output Live or in QBF, you can choose File>>Print to send the report
to a window, printer, or disk file.
When you print a report to a window on screen, a printer, or a disk file, each group level in the
document dynamically expands to accommodate all the requested data, as shown in the figure
below.
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When the GUEST LIST report is printed, DataEase displays the data for all members arriving
at Club Coba on December 26, 1995.
This Summary field shows a count of guests arriving at Club Coba from Atlanta.
At the end of Club Coba's listing, a Summary field shows the total count of guests arriving at
that club from all cities.
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Closing a Document
When you choose File>>Close, DataEase closes the active document.
If you try to close a form before saving changes to a record, you receive the following
message:

The Data Changes alert message lets you quickly save your work. Choose:
• Yes to save the changes and close the form. DataEase updates the record on screen.
• No to abandon the changes and close the form.
• Cancel to return to the form.
Note:

To save your changes as a new record, click Cancel and choose Edit>>Save As
New Record.
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Deleting a Document
When you choose File>>Delete, DataEase displays the Delete a Document dialog. This dialog
is used to delete a document (and optionally, the corresponding table) from the current
application.

Delete a Document Dialog Options
Documents displays all the documents in the current application. Click on a document to
select it.
Before DataEase deletes a document, DataEase displays a Delete Document alert message,
which lets you confirm or cancel the deletion of your document. To confirm the deletion, click
OK. To cancel the deletion, click Cancel.
You must have a High Security Level to delete a document. See the Designer's Guide for
more information on document security.

© DataEase International Ltd

81

Printing a Document
When you choose File>>Print, DataEase displays the Print dialog shown below. The Print
dialog is used to print the records in the active form or report.
You can also choose to print a document with its display attributes if your printer supports
multiple-size fonts and graphics.

Print Dialog Options
You must have a printer connected to print a document.
Destination defines the print destination. Choose:
• Printer to send the document to the selected printer.
• File to copy the document to the disk file you specify in the text box. Enter the full pathname
of the file (including disk drive and directory). If you do not specify a pathname when you
print to a file, DataEase uses the directory of the current application.
• Window to print the document to the screen. When you print to a Window, DataEase
changes the Print button on the Toolbar to the Print Done button. To switch back to the
document in User View, select the Print Done button or press Esc.
Options is used to set the following:
• Print Detail, which specifies print quality. Choose:
• Text for quick printing with letter quality output that includes only data and document text.
• Draft for quick letter quality output that includes image frames (outlines) and lines,
rectangles, and ellipses printed in a uniform shade.
• WYSIWYG (What You See Is What You Get) to print a representation of your document that
includes multiple typefaces, images, and other graphical elements.
See Designer Guide Chapter 6 for information on setting Display Print Options for an object.
See the Microsoft Windows User's Guide for information on installing a printer.
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• Report Form Expansion, which specifies the number of Subform or grouped records that
print on a page. You can use this option to override the report layout originally specified in
Designer View.
• Expand Layout to print all the Subform or grouped records.
• Fixed Layout to limit the number of Subform or grouped records that print on a page.
• Copies, which indicates the number of copies printed. The value must be 1 or greater. The
default is 1.
• Collate copies, which turns on or off the feature that prints pages in proper numerical order
when you print multiple copies of a document. Your printer must support collated copies to
use this feature. The default is off.
Note: Print options for each document can be set with Document>>Print Options. Default
options for new documents can be set in Application>>Preferences.
If the document designer has chosen to bypass the Print Document dialog, the document
prints immediately using the default options.
To print images, you must have a printer that supports graphics. You can specify that an object
does not print by choosing the Don't Print option in Designer View.
Range tells DataEase which set of records to include in the printout. Choose:
• All Records to print the records in a document that match the specified QBF or QBM
selection criteria, if any. If no selection criteria are specified, DataEase prints all the records.
This is the default option.
• Current Record to print the record currently displayed on your screen.
Pages tells DataEase which range of pages to send to the printer. Choose:
• From to specify the first page you want printed.
• To to specify the last page you want printed.
See User Guide Chapter 1 for information on setting Display Print Options for an object.
DataEase uses From = 1 and To = 9999 as the default Range.
Pages indicates the total number of pages, not the page numbers of a document. For
example, to print the first two records in a two-page form, specify 1 to 4 in the Pages text
boxes.
Setup displays the Print Setup dialog shown later in this section.
See USER GUIDE Chapter 1 for information on setting Display Print options for an object.
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Sending the Print Job
When you complete the Print dialog and click OK, DataEase reduces the active document to
an icon, creates a print job in your system's memory, and sends it to Windows Print Manager.
DataEase then displays a printing status window.

Example: Printing the Current Record in a Form
In this example, the current record in the CLUBS form is printed using the WYSIWYG Print
Detail.

Printout with Current Record selected in Form View.

Printout showing Table View

Example: Printing All Records in a Form
When you print records in a Multiform, DataEase prints all the Subform records associated
with each Main form record (you cannot limit the number of Subform records).
In this example, all records in the CLUBS form are printed using the WYSIWYG Print Detail,
and with Table View selected, rather than Form View.
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How to Print the Records in a Form
1

Open the form that contains the records you want to print.

2

Choose File>>Print. DataEase displays the Print dialog.

3

Choose the desired print options.

4

Click OK. DataEase displays the printing status window.

How to Print Selected Pages of a Document
1

Open the document you want to print.

2

Choose File>>Print. DataEase displays the Print dialog.

3

Choose Pages. Enter the number of the first page in the From text box and the number
of the last page in the To text box.

4

Click OK. DataEase prints only the pages in the range you specify.

How to Print the Graphic Objects in a Document
1

Open the document you want to print.

2

Choose File>>Print. DataEase displays the Print dialog.

3

Choose the WYSIWYG Print Detail.

4

Click OK. DataEase displays the printing status window.
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Selecting and Configuring a Printer
When you choose File>>Print Setup, DataEase displays the Print Setup dialog shown below.
This dialog is used to select the printer used each time you print from DataEase and to change
the settings used with a printer.

Print Setup Dialog Options
Printer tells DataEase which of the active printers to use. DataEase lists only the printers you
have installed and specified as active in Windows. Choose:
• Default Printer to select the current printer. DataEase automatically uses the Windows
default printer as the Default Printer.
• Specific Printer to change the Default Printer.
Orientation tells DataEase which orientation to use when a document is printed. Choose:
• Portrait to print using the vertical orientation.
• Landscape to print using the horizontal orientation.
Paper tells DataEase which paper size and sheet feeding mechanism to use when printing a
document. Choose:
• Size to choose a nonstandard paper size (e.g., 11 by 14 inches) that is supported by your
printer.
• Source to choose how paper feeds into your printer from the available sheet feeding
mechanisms (upper tray, lower tray, tractor, or manual).
Options opens the Print Options dialog. This dialog is used to specify additional options for the
selected printer.
Note: The appearance of the Print Setup dialog varies with the specified default printer. You
can choose only from the features supported by your printer.
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Use the Windows Control Panel to install and activate other printers.

See DESIGNER GUIDE Chapter 7 for information on the Print Options dialog.

How to Select the Default Printer
1

Choose File>>Print Setup.

2

Click on the Specific Printer drop-down arrow.

3

Click on the name of the printer.

4

Click OK. DataEase displays the Print dialog with the new printer listed as the default.

How to Configure a Printer
1

Choose File>>Print Setup. DataEase displays the Print Setup dialog.

2

Choose the default Print Orientation (Portrait or Landscape).

3

Click on the Size drop-down arrow. Choose the default paper size.

4

Click on the Source drop-down arrow. Choose the default paper tray or paper feed method.

5

If your version of Windows supports the Print Options dialog, click Options. DataEase
displays the Print Options dialog. Choose the options and values you want and click OK.
DataEase displays the Print Setup dialog.

6

Click OK.
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Importing and Exporting Data
In addition to the Windows Clipboard and the DDE and OLE features for exchanging data,
DataEase includes two File menu options (Import and Export) that let you quickly import large
amounts of data from other DOS and Windows programs into a DataEase table or export data
from DataEase to database, spreadsheet, word processor, and other popular software
programs.

When to Use Import and Export
In addition to speeding up data exchange, DataEase Import and Export commands let you:
• Upgrade from another product, using the Import command to convert your existing data into
the DataEase format.
• Use special capabilities of other software products which are not available in DataEase,
such as the spell checker found in many current word processors or the business
presentation features of contemporary spreadsheet and graphics programs.
• Take advantage of disk-based mailing lists, catalogs, and other data packages available
from independent vendors.
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Importing Data into a DataEase Table
See DESIGNER GUIDE Chapters 3 and 6 for information on creating a form and table.
See DESIGNER GUIDE Chapter 7 for information on setting Document security levels.
DataEase lets you import data into any database table with columns defined to match the size
and Data Type of the incoming data. You can use the Import option to add data to an existing
table, or you can design a new form and table with fields that match the incoming data.
DataEase lets you create and save a predefined import, which lets you import data using the
same basic instructions repeatedly without having to define the import each time.
To import data, you must have a security level that lets you enter records in the form that
defines the destination table.
To begin an import, choose File>>Import from anywhere in DataEase.
DataEase displays the Import Data dialog, which lets you specify the data format, source file,
field sequence, and other information that defines how DataEase imports data from another
program.

Import Data Dialog Options
Import displays the name of the predefined import you have open.
Directory displays the name of the directory containing the predefined import you have open.
Destination Table Name lets you choose the destination table, the table you want to import
data into. DataEase fills in this value if you have a table open when you choose File>>Import
or if you open a predefined import.
Import Format Type lets you choose any one of the ten import file formats summarized in the
table below.
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Summary of Import File Formats
Import Format Type

Use to Import from...

Default File Extension

Variable Length Text
(Windows ANSI)

Windows Applications

.DAT, .TXT

Variable Length Text
(IBM PC OEM)

DOS or OS/2 Programs

.DAT, .TXT

Fixed Length Text
(Windows ANSI)

Windows Applications

.DAT, .TXT

Fixed Length Text

DOS or OS/2 Programs

.DAT, .TXT

Lotus 1-2-3

Lotus 1-2-3, Lotus Symphony

.WKS, .WK1

DataEase

Another DataEase Application

.DBM

DataEase 4.x

DataEase Character-based
Database

.DBM

dBASE

dBASE II, III, III+, IV

.DBF

DIF

VisiCalc, Spreadsheets

.DIF

Mail Merge

WordStar

.MRG

(IBM PC OEM)

Note: Choose Windows ANSI to use the American National Standards Institute character set.
Choose IBM PC OEM to use the IBM Personal Computer character set.
See the sections, Importing Data from a Variable Length Text File and Importing Data
From a Fixed Length Text File, later in this chapter, for more information on how to
determine the format characteristics of a text file.
Import Source Filename tells DataEase the name and location of the source data file. If the
source file is in the same directory as the current application, simply enter its filename. If the
file is stored in a different directory, specify the DOS path in addition to the filename.
Browse displays the Import Data File dialog, which lets you search your disk for the source
file.
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Source data is organized by: tells DataEase whether to import data into destination fields
based on Field Name or Field Order. Choose:
• Field Name if the Import source file contains the name of each field in the first record. If you
select this option, DataEase transfers data from a source field into a destination field only if
the source and destination fields have the same Field Name. Data in a source field that does
not have a matching destination field is not imported. When comparing field names for this
transfer, DataEase treats upper and lower case as identical (i.e., it is case-insensitive).
• Field Order if the Import source file does not include Field Names. If you select this option,
DataEase imports the first field in each source record into the first field in the destination
table, the second source field into the second destination field, etc. If the source file has
fewer fields per record than the destination table, the excess destination fields receive a
blank (null) value.
Note: When DataEase imports data organized by Field Order, the field sequence in the
source file must exactly match the field sequence in the destination table. To view the field
sequence in a table, display the table by double-clicking on its name under the Tables heading
(or Database Links heading for an SQL table) in the Application Catalog or use the Data Model
Manager.
Field Separator tells DataEase what delimiter character distinguishes one field value from the
next in a Variable Length Text source file. For example, many software programs use a
comma or tilde (the DataEase default) to separate fields. To select a character not included in
the drop-down list, choose Other and type the desired character in the text box.
Record tells DataEase what delimiter character distinguishes one record from the next in a
Variable Length Text source file. For example, many software programs use a new line
character (the DataEase default) to separate records. To select a character not included in the
drop-down list, choose Other and type the desired character in the text box.
Note: To determine what character is used to separate records and fields in a Variable Length
Text file, view it in Windows Notepad or another product that edits ASCII text.
Run executes the import specified in the Import Data dialog. While running the import,
DataEase checks the import specification for errors. If an error is detected, DataEase displays
an error message box.
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Close closes the Import Data dialog. If you create a predefined import or make changes to an
existing predefined import, DataEase displays a message box asking you if you want to save
the changes to the import. Click Yes to save the changes, No to delete the changes.
Open displays the Open Predefined Import dialog, which lets you select a predefined import.
When you open a predefined import, DataEase displays the values chosen for the import in the
Import Data dialog.

Note: In the Open Predefined Import dialog, DataEase displays the application's directory as
the default directory.
Save opens the Save Predefined Import dialog, which lets you name an import and save it to
disk. You can give the predefined import a filename of up to eight characters. The Save button
also lets you save any modifications you make to an existing predefined import.
The Save Predefined Import dialog is similar to the Open Predefined Import dialog.

Save As opens the Save As Predefined Import dialog, which lets you save a copy of an
existing predefined import with a new name.
The Save As Predefined Import dialog is similar to the Save Predefined Import dialog.
Delete opens the Delete Predefined Import dialog, which lets you select a predefined import
name to delete.
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Options displays the lower part of the Import Data dialog.
Import Checking displays the destination table name and lets you specify what DataEase
should do when the values in the Unique fields in an Import record match those of an existing
record in the destination table. Records match when the values in all the Unique fields are
identical. Choose:
• Add all records (Fast Import) to import all records in the source file. This is the default
option. DataEase adds the imported records to the existing records in the destination table
without checking Unique field values for matching records. This option is the quickest way to
import a large number of records into a table.
• To save time when performing an import, we recommend you choose Add all Records under
the following conditions: (1) the destination table is empty, (2) the destination table does not
contain matching records, or (3) the existence of matching records in the destination table
does not matter.
• Add non-Matching Records to import only source file records that do not match a record in
the destination table. DataEase adds the non-matching records to the destination table.
Matching records are not imported but are listed in the Import Exception file.
• Update Matching Records to import only records that match a record in the destination
table. DataEase updates (overwrites) each matching record in the destination table with the
imported record. Non-matching records are not imported but are listed in the Import
Exception file.
• Add or Update Records to import all the source file records, add non-matching records,
and overwrite matching records in the destination table, but check for Unique fields.
Lock destination table during import prevents other users from accessing the destination
table until the import is complete. This is the default option. Although DataEase imports data
more rapidly when the table is locked, you can disable this option if other users must have
access to the table during an extended import.
{bml Ug__0002.BMP}When you import data into a form that defines or uses an SQL table,
DataEase replaces the Lock destination table during import option with the Use server batch
facility option (explained later in this chapter).
Insert decimals for fixed point fields tells DataEase to insert a decimal point when importing
data from a source file into a Fixed Point Number field. This option is deactivated by default.

© DataEase International Ltd

93
When this option is selected, DataEase inserts a decimal point at the location specified by the
target field definition. For example, if you import the value 25000 into a Fixed Point field that
requires two digits to the right of the decimal point, DataEase stores the value as 250.00.
If you do not check this option, DataEase does not insert a decimal point. However, DataEase
does import decimal points that exist in the source file. For example, when importing data into
a Fixed Point field that requires two digits to the right of the decimal point, DataEase stores the
value 25000 as 25000.00 and stores 17.5 as 17.50.
DataEase disables this option if the destination table contains no Fixed Point Number fields.

Importing Data from a Variable Length Text File
Because the format of Variable Length Text files can vary, we recommend that you use
Windows Notepad or another text editor to view a file and determine its format characteristics
before importing its data. To choose the correct settings in the Import Data dialog, you must
determine whether the file's first record contains field names and what characters are used to
separate fields and records.
The figure below shows a sample Variable Length Text file and explains the settings you select
in the Import Data dialog to import it. Each record in the file contains three fields, STATE,
CITY, and ZIP CODE.

Note: To import data organized by Field Name from a Variable Length Text file that does not
contain Field Names, use a text editor to insert a new first record containing the Field Names.
DataEase does not remove Text Delimiter characters other than quotation marks. If a source
file uses a different Text Delimiter, use the search-and-replace feature of your text editor or
word processor to replace the characters with quotation marks before the data is imported.
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Importing Data from a Fixed Length Text File
In a Fixed Length Text file, each field has a predefined, non-variable length. Because the
length of each field (and therefore, each record) is fixed, it is not necessary to use delimiter
characters to mark the beginning of field values and records.
The figure below shows a sample Fixed Length Text file displayed in Windows Notepad. Each
record in the file contains three fields, STATE, CITY, and ZIP CODE.

To import data from a Fixed Length Text file, the field values in each source record must
appear in the same order as the corresponding fields in the destination table. In addition, each
source field value must contain exactly the same number of characters (including spaces) as
its destination field. Otherwise, DataEase cannot accurately distinguish where each field
begins, and data errors will occur.
Note: If you import data from an ASCII text file into a Fixed or Floating Point Number field, and
the source data contains decimal points, do not count the decimal point when you determine
the length of the ASCII source field.
ASCII data imported into a Number field must not include commas.
Determining Field Sequence and Field Length
To display a DataEase table and view its field sequence, double-click on the Tables icon in the
Application Catalog, then double-click on the desired table name.
To confirm the size of a destination field, open the target form in Designer View, then display
the Field Definition dialog for that field.

Exception Files
DataEase automatically performs all required field validation checks on the data imported from
a source file. If a source file field value does not satisfy the requirements of the target field, the
entire record is discarded.
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When a record does not fully conform to the target form definition, DataEase lists that record in
an Exception file. The Exception file contains the source file record number of each discarded
record, as illustrated in the figure below.

If errors occur, DataEase displays a dialog that specifies the full pathname of the Exception file
when the import is completed. If you want to view the Exception file immediately, click Yes. If
you choose No, you can view the Exception file at any later time using Windows Notepad or
another text editor.

Import Summary
During an import, DataEase displays an import summary in the Status Bar at the bottom of the
screen. The figure below illustrates a typical import summary.

How to Import Data into a DataEase Table
1. Choose File>>Import. DataEase displays the Import Data dialog.
2. Choose the Import file format.
3. Specify the path and filename of the source file.
If the source file is stored in the application directory, you don't need to specify a path. You can
click Browse to search for the source file.
4. Specify whether the source data is organized by Field Name or Field Order.
If the source file includes field names in the first record, accept Field Name (the default). If the
first record contains data values, select Field Order. When you import records organized by
Field Order, fields in the source file must appear in the same sequence as in the destination
table.
Specify which characters are used as field and record separators (for Variable Length Text
format only).
To specify the character used to separate fields or records, choose the appropriate character
from the Field Separator or Record Separator drop-down list in the Import Data dialog. If the
appropriate character does not appear on the list, select Other, then type the character in the
entry box.
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5. Click Run. DataEase closes the Import Data dialog, imports the records, and displays the
progress of the import in the Status Bar. Once you click Run, you cannot cancel or abort an
import.

How to Create and Run a Predefined Import
1. Choose File>>Import. DataEase displays the Import Data dialog.
2. Choose the Import file format.
3. Specify the path and filename of the source file.
If the source file is stored in the application directory, you don't need to specify a path.
You can click Browse to search for the source file.
•

Specify whether the source data is organized by Field Name or Field Order.

•

If the source file includes field names in the first record, accept Field Name (the
default). If the first record contains data values, select Field Order. When you import
records organized by Field Order, fields in the source file must appear in the same
sequence as in the destination table.

•

Specify which characters are used as field and record separators (for Variable Length Text
format only).
To specify the character used to separate fields or records, choose the appropriate character
from the Field Separator or Record Separator drop-down list in the Import Data dialog. If the
appropriate character does not appear on the list, select Other, then type the character in the
entry box.

1. Click Save. DataEase displays the Save Predefined Import dialog.
2. In the Import File box, enter a name of up to eight characters and click OK. DataEase names
the predefined import and returns you to the Import Data dialog.
3. Click Run. DataEase imports the records and displays the progress of the import in the
Status Bar.

Using the Server Batch Facility
The server batch facility is an SQL engine feature that is used to insert a group of records into
a table in a single step rather than one at a time, greatly reducing the time it takes to perform
an import.
If you are importing data into a form that defines or uses an SQL table, DataEase replaces the
Lock Destination Table During Import option in the Import Data dialog with the Use server
batch facility option, as shown in the figure below.

If your server supports the DataEase server batch facility and you import records with this
option selected, DataEase copies a batch of records into memory. If no invalid data is
discovered, the entire batch is entered as a unit. If any records in the batch are invalid,
DataEase retrieves the entire batch and inserts the records into the destination table one at a
time, discarding the invalid records in the process. Discarded records are noted in the
Exception file.
When all records for the first batch have been inserted, DataEase processes the next batch of
records.
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Note: When DataEase inserts records one at a time, each INSERT statement is treated as a
separate transaction.

Customizing the Batch Size
The default batch size depends on your database engine type. You can customize the batch
size by modifying the database engine .INI file (e.g., DESYBASE.INI, DEDB2.INI, etc.) in your
DataEase System directory.
For example, the DESYBASE.INI file contains the lines:
ADD_BATCH_SIZE=50
UPDATE_BATCH_SIZE=25
….where 50 records is the default batch size if you choose the Import New (Unique) Records
option and 25 records is the default batch size if you choose the All Records option.

How Changes in the Batch Size Affect Performance
If you change the value of ADD_BATCH_SIZE in the database engine .INI file, the modification
also affects the batch size used by restore, data transfer, and form modification operations in
all your applications that use that SQL engine.
If you import a large amount of data, you can increase the batch size to speed up the import.
However, if one record in the batch fails, DataEase retrieves the entire batch and inserts each
record individually. If this happens, you may notice a drop in performance.
Note: Because each batch of records is stored in memory, increasing the batch size may
cause an out of memory error.
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Exporting DataEase Data
The DataEase export utility lets you export data from a DataEase application to another
DataEase (DOS or Windows) application or another software program. The export utility is
especially useful if you want to use DataEase data in a non-Windows application. For example,
you can use the export utility to merge a DataEase data file with a DOS-based word
processing document, such as a form letter, or to export numerical data from DataEase for use
in a DOS-based spreadsheet or business graphics program.
To export data from DataEase, open the table that contains the records you want to export by
double-clicking on its name in the Application catalog, then choose File>>Export. DataEase
opens the Export Data dialog, which lets you select which records and fields to export, and
specify the format, filename, and other information about how the export file should be
structured.

To export data, you must have a security level that lets you view records in the form that
defines the source table.
You can filter the records you want to export using QBF or QBM to specify your selection
criteria before you open the Export Data dialog. When you open the Export Data dialog,
DataEase selects the records that match your selection criteria. If you have entered selection
criteria and choose Range to select a subset of the records, DataEase exports a series of
sequential records that match your criteria.
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Export Data Dialog Options
See USER GUIDE Chapter 7 for information on how to enter QBF selection criteria.
Export Format Type lets you choose one of five file formats for the exported data. The
formats are summarized in the table below.

Export File Formats
Export Format

Use to Export

Type

from...

Default File
Extension

Variable Length Text
(Windows ANSI)

Windows Applications

.DAT, .TXT

Variable Length Text
(IBM PC OEM)

DOS or OS/2 Programs

.DAT, .TXT

Fixed Length Text
(Windows ANSI)

Windows Applications

.DAT, .TXT

Fixed Length Text (IBM
PC OEM)

DOS or OS/2 Programs

.DAT, .TXT

Lotus 1-2-3

Lotus 1-2-3, Lotus
Symphony

.WKS, .WK1

Note: Choose Windows ANSI to use the American National Standards Institute extended
character set.
Choose IBM PC OEM to use the IBM Personal Computer extended character set.
Export File Name lets you enter the full pathname for the export file DataEase creates.
Browse opens the Browse dialog. If you want to overwrite an existing export file with more
current data, the Browse dialog lets you search your directory structure to find the target file.
For example, if you export data on a regular basis for use in a mail merge with your word
processor, you can overwrite the same file with new information each time you export data.
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Include Field Names tells DataEase to include the Field Name of each selected field in the
first record in the export file. This option is not available if you choose the Fixed Length Text
export format.
Field Separator lets you select a delimiter character to be placed between each of the fields in
the export file. This character allows the program importing the data to distinguish one field
value from the next. To select a character not included in the drop-down list, choose Other and
type the desired character in the text box. A Field Separator is available only for the Variable
Length Text format.
Record Separator lets you select a delimiter character to be placed between each record. To
select a character not included in the drop-down list, choose Other and type the desired
character in the text box. This option is available only for the Variable Length Text format.
Note: If the target program requires specific record and field separator characters, enter these
in the Field Separator and Record Separator boxes. If the target program does not impose any
restriction on the characters used as Field and Record separators, consider using a new line to
separate records and any character that does not appear in the data (e.g., tilde ~, or pipe |) to
separate fields.
Be sure to select field and record separator characters that do not appear in the data.
Otherwise, data import errors may occur in the target program.
Options displays the lower part of the Export Data dialog.
Text Delimiter lets you specify a special text delimiter required by some import formats. Many
software programs require that data stored in a text field be delimited by a specific character,
frequently double quotation marks ("). This character allows the target program to distinguish
field values that include embedded spaces from adjacent field values. DataEase does not
specify a special text delimiter by default; if the target program requires one, select one from
the drop-down list, or choose Other and type the desired character in the entry box. The Text
Delimiter option is available only for a Variable Length Text export format.
Table lets you select the name of the table from which you want to export data. If you are
exporting data from a Multiform, you can choose the table associated with the Main form or
any one of its Subforms.
If you choose a table associated with one of the Subforms, DataEase will export only those
Subform records that are related to the currently displayed Main form record. If you wish to
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export all the Subform records, open that table directly from the Application Catalog before
specifying your export.
Selected Records lets you select which records you want to export. Choose:
• Current to export data from only the record that is currently displayed on the screen.
• All to export data from all the records in the table you select (e.g., if the source form is a
Multiform, the selected table can be associated with the Main form or any of the Subforms).
This is the default option.
• Range to select a series of sequential records.
Selection Boxes let you enter the first and last row numbers that define the range of records
you want to export.
Fields displays a list of all the fields in the table associated with the form you select from the
Table drop-down box. As each field is selected, it is added to the Selected Fields box. If All
fields are selected, the list in the Fields box is grayed.
Selected Fields lists all the fields to be included in the export file. DataEase selects all fields
by default. To select only specific fields, you must first delete unwanted fields using the
Remove button.
All places all fields from the Fields list box into the Selected Fields list box.
Add places the field that is currently highlighted in the Fields list box into the Selected Fields
list box. To add several fields at once, drag the mouse to highlight the appropriate fields, then
click Add.
Remove deletes the currently highlighted field(s) from the Selected Fields list box. To remove
several fields at once, drag the mouse to highlight the appropriate fields, then click Remove.
Note: If you want to arrange the fields in the export file in a specific order (e.g., to match the
field order in the target program), you must first remove all the fields from the Selected Fields
box and then add them back in the desired order.

Sample Export File
The export file output that DataEase generates depends on the Export Format Type you
select. For example, suppose you want to use your word processor to send a form letter to all
the Club ParaDEASE members who live in the state of Connecticut. First, open the MEMBERS
form in User View. Then, using QBF or QBM, enter the appropriate selection criteria (e.g.,
STATE = "CT") in the Record Selection Filter box.
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The export file DataEase creates is a Variable Length Text file which uses a Tilde as the Field
Separator character, a New Line as the Record Separator character, and no Text Delimiter.
When you open the Export Data Dialog and click the Options button, notice that DataEase
displays only seven records in the Selection Boxes, since only seven members live in the state
of Connecticut.

Using the settings shown above, DataEase generates a Variable Length text file that looks like
the following sample:

© DataEase International Ltd

103

How to Export Data
1. Open the form or table that contains the records you want to export in User View. Use QBF
or QBM to enter selection criteria to filter the records to be exported.
2. Choose File>>Export. DataEase displays the Export Data dialog.
3. Select an Export Format Type (Variable Length Text, Fixed Length Text, or Lotus 1-2-3).
4. Type an Export File Name, including the drive letter and directory path. Optionally, you can
click Browse and search your directory structure for a previously defined export file.
The remaining steps are optional.
1. Check Include Field Names if you want to include the name of each selected field as the first
record in the export file.
2. Choose a Field Separator character from the drop-down list, or choose Other and type the
desired character in the entry box. Be sure to select a character that does not appear in the
data. This option is only available if you choose the Variable Length Text export format.
3. Choose a Record Separator character, or choose Other and enter a character that does not
appear on the list. Be sure to select a character that does not appear in the data. This
option is only available if you choose the Variable Length Text export format.
4. Click the Options button, then choose the name of the Table that contains the records you
want to export.
5. If the target program requires a special Text Delimiter in addition to the Record Separator,
choose one from the drop-down list or choose Other and enter another character.
6. Choose which records (Selected Records) to include in the export file: Current, All, or
Range. If you choose Range, enter the first and last record numbers in the text boxes.
7. Remove any Selected Fields that are not required for the export. Click OK. After you close
the Export Data dialog, DataEase immediately begins creating the export file. While this
process is taking place, DataEase displays a message box that tracks the progress of the
export. Click Cancel or press Esc to abort the export process.
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Switching from User to Designer View
See USER GUIDE Chapter 1 for information on the menus available in each view.
There are two views in DataEase.
• User View is the data-oriented environment. When a DataEase form is open in User View,
you can use it to view the form, and to enter and modify data records. User View also lets
you use Query by Example techniques to find and analyze data stored on one or more
computers.
• Designer View is the application design environment where you create the data-entry forms,
reports, and custom menus used in your application.

When you choose File>>Designer View, DataEase displays the active document in Designer
View.
DataEase lets you switch views with one mouse click. Once a document is displayed in
Designer View, you can modify its layout.
While you design a document, you can move repeatedly between views to test field
characteristics and to see how the layout and styles you create appear in User View.
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Closing an Application and Exiting DataEase
See USER GUIDE Chapter 1 for information on the menus DataEase displays when you close
an application.
When you choose File>>Close Application, DataEase closes the current application,
including all the open documents and the Application Catalog Window. When you choose this
option, DataEase displays the Close Application alert message shown below.
When you choose File>>Exit, DataEase exits DataEase and returns you to the Windows
Program Manager. When you choose this option, DataEase displays the Close Application
alert message shown below.

The Close Application alert message lets you return to the application. Click:
• OK to close the application.
• Cancel to return to the application.
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Chapter 4 : The Edit Menu
Entering and Modifying Records and Controlling Record Access
The Edit menu options are used to modify, save, delete, and restore records, modify Object
Linking and Embedding (OLE) links and objects, and control record access and display in a
multi-user environment.
Each menu option is summarized in the table below and explained in detail on the following
pages.

Summary of Edit Menu Options
Menu
Option

Keyboard Equivalent

Menu Option
Is Used to...

Undo
Typing

Alt + E, U Ctrl + Z

Restore the value in the current field to the version stored in
memory.

Cut

Alt + E, T Ctrl + X

Remove the selected data or object(s) and place it in the
Clipboard.

Copy

Alt + E, C Ctrl + C

Copy the selected data or object(s) to the Clipboard.

Copy
Record

Alt + E, R Ctrl + R

Copy the selected data or object(s) to the Clipboard.

Copy
Special

Alt + E, I

Copy data in selected fields from one or more records to the
Clipboard.

Paste

Alt + E, P Ctrl + V

Paste the contents of the Clipboard in the current field or
record.

Clear
Field

Alt + E, L F6

Erase all the data in the current field without placing it in the
Clipboard.

Clear
Form

Alt + E, F F5

Display a blank record.

Save

Alt + E, S F8

Modify an existing record using the data currently displayed
on screen. If you enter data in a blank record, Save creates a
new record.

Save As
New
Record

Alt + E, A F2

Create a new record in the database table using the data
currently displayed on screen.

Delete
Record

Alt + E, D F7

Remove the current record from the form (and any Subform
records specified by referential integrity) and mark it deleted.

Restore
Record

Alt + E, E Ctrl + F5

Return a record that is marked deleted to the form. If a record
has not been saved,, Restore Record restores the last saved
version.

Links

Alt + E, K

Display and modify Object Linking and Embedding (OLE)
links to other applications.

© DataEase International Ltd

107

Object

Alt + E, O

Modify an OLE object.

MultiUser
Options

Alt + E, M

Control record access and display in a multi-user
environment.
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Selecting Text
Before you Cut or Copy, you must first select the specific text you want to work with. Using a
mouse or the keyboard, you can select one, many, or all characters in one field, but the
characters you select must be continuous.

How to Select Text
1. Place the cursor before the first character you want to cut or copy. Hold down the left mouse
button, drag the mouse until the cursor is placed after the last character to be cut or copied,
and then release the mouse button.
2. Alternatively, hold down the Shift key, place the cursor after the last character to be cut or
copied, and then release the Shift key.
3. DataEase highlights the selected text in reverse. Note that Playa Blanca is highlighted in the
picture below.
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Canceling Your Last Action
When you choose Edit>>Undo Typing, DataEase restores the previous value in the current
field. You cannot undo a value that has been saved to the database.
Note: You can also abandon a field modification by pressing Esc.
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Editing Data and Objects
When you choose Edit>>Cut, DataEase deletes the selected data or object(s) and places it in
the Clipboard. DataEase overwrites any data or object(s) previously stored in the Clipboard.
When you choose Edit>>Copy, DataEase duplicates the selected data or object(s) and places
it in the Clipboard.
When you choose Edit>>Paste, DataEase inserts the Clipboard's contents into the current
record. If the Clipboard contains:
• One field value, DataEase inserts the value in the current field.
• Multiple field values, DataEase can insert copied values in another record in the same form
or in another form that has the same field names as the original record.

How to Paste a Field Value(s) from One Document to Another
1. With one or more values saved to the Clipboard, go to the new document.
If only one value is stored in the Clipboard, make sure the field definition of the target field is
compatible with the value. For example, DataEase will not accept the value Sam in a field
defined as a Number field.
If more than one value is stored in the Clipboard, make sure that the new document contains
the same fields as the original document. For example, you can copy the NAME, ADDRESS,
and PHONE values from one form to another only if both forms contain identically named
fields.
1. Choose Edit>>Paste. DataEase inserts each value in the field that has the same Field
Name (e.g., the CITY value in the original form is inserted in the CITY field on the new
form). DataEase retains these values in the Clipboard until you cut or copy another value.
2. To insert these field values in another record, repeat steps 1 and 2.
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How to Copy a Field Value to Another Record
1. Select the text to be copied. DataEase highlights the selected text in reverse.
2. Choose Edit>>Copy. DataEase places the highlighted text in the Clipboard.
3. Position the cursor where you want to insert the value in the field.
4. Choose Edit>>Paste. DataEase inserts the value from the Clipboard in the specified field.
DataEase stores the value in memory until you cut or copy another value to the Clipboard.
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Copying All Record Data
When you choose Edit>>Copy Record, DataEase copies all values from the current record
into the Clipboard. In a Multiform, the Copy Record option duplicates either the Main form
record or the current Subform record, depending on the cursor's location.
The Copy Record option lets you keep a default record in memory and quickly insert these
values in a new record. This operation allows you to save time when you enter records that
have many values in common.

How to Copy All Data from One Record to Another
1. Choose Edit>>Copy Record. DataEase copies the data in each field in the current record to
the Clipboard.
2. Choose Edit>>Clear Form. DataEase displays a blank record.
3. Choose Edit>>Paste. DataEase copies the data in each field to the identically named field in
the new record. DataEase stores these values in the Clipboard until you cut or copy another
value.
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Copying Selected Field Data
When you choose Edit>>Copy Special, DataEase displays the Copy Special dialog, which
lets you copy data from selected fields in one or more records to the Clipboard.

Copy Special Dialog Options
Table Selection List lists the fields in the form. If the form is a Multiform, select the form that
contains the fields you want to copy. Otherwise, do not change this value.
Record Selection lets you select the records to copy. Choose:
• Current to copy values from the current record.
• All to copy values from all the records in the selected table.
• Range to copy values in a subset of records specified in the boxes below this option. Enter
the first and last records' positions in the form in these boxes (e.g., to copy values in the
second through fifth records, enter 2 and 5).
Fields lists all fields in the selected table.
Selected Fields lists the fields in the selected table that DataEase will copy. Use the All, Add,
and Remove buttons to control the fields that appear in this box.
All places all fields in the Fields box in the Selected Fields box.
Add places the highlighted field(s) in the Fields box in the Selected Fields box.
Remove deletes the highlighted field(s) from the Selected Fields box.
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Clipboard Formats
When you choose Edit>>Copy Record or Edit>>Copy Special, DataEase copies text to the
Clipboard in three formats:
• DataEase Data Format is used to transfer data to other DataEase documents.
• Text Format (CF_TEXT) is used to transfer data into other Windows applications such as
Microsoft Excel or WordPerfect for Windows.
• Link Format is used transfer data into another Windows application as a linked object.
When you choose Edit>>Copy, DataEase copies the text in two formats: Text Format and
Link Format.

How to Copy the Data in Multiple Records
1. Choose Edit>>Copy Special. DataEase displays the Copy Special dialog.
2. If the form is a Multiform, select the form that contains the fields you want to copy. The
default form is the one in which the cursor is positioned.
3. Select which records in the form you want to copy: the current record, a range of records, or
all records. If you want to copy a range of records, enter the number of the first and last
records you want to copy.
If the cursor is in a Main form, the default is the current record.
If the cursor is in a Subform, the default is all Subform records.

How to Copy the Data in Multiple Fields
1. Highlight the field you want to copy in the Fields Box and click on the Add button. DataEase
places the Field Name in the Selected Fields Box.
2. Repeat step 1 until all the fields you want to copy are in the Selected Fields Box.
3. If you are copying most of the fields, click on the All Button. Delete any field you do not want
to copy by highlighting the field in the Selected Fields Box and clicking on the Remove
Button.
4. Click OK. DataEase copies the data in all the selected fields to the Clipboard.
Note: You can use Copy Special to copy data in queried records. First select and/or sort the
records and then choose Edit>>Copy Special. DataEase copies the information from the
queried records based on the information you enter in the Copy Special dialog.
If you paste multiple records (copied using Edit>>Copy Special) in another DataEase
document, the data you paste overwrites the data stored in the corresponding number of
consecutive records. If you do this by mistake, close the form without saving changes.
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Clearing a Field
See USER GUIDE Chapter 7 for information on Query By Form.
When you choose Edit>>Clear Field, DataEase deletes any data, selection criteria, or sort
order information in the current field.

How to Delete a Field Value
1. With the cursor in the field you want to clear, choose Edit>>Clear Field.
2. DataEase deletes the data in the field. Any value(s) stored in the Clipboard before you
choose Clear Field remains intact.

How to Clear QBF Criteria from a Field
1. Choose Query>>Select Records or Query>>Sort Records. DataEase displays the current
QBF selection criteria or sort order.
2. Position the cursor in the field you want to clear.
3. Choose Edit>>Clear Field. DataEase erases the QBF selection criteria or sort order in the
specified field from memory and displays a blank field.
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Clearing a Record
See DESIGNER GUIDE Chapter 7 for information on Query By Form.

When you choose Edit>>Clear Form, DataEase erases all the data, selection criteria, or sort
order information in the current record.

How to Clear a New Record
1. At any time before you save the record, choose Edit>>Clear Form. DataEase displays a
dialog that asks if you want to discard the entered data.
2. Click OK. DataEase permanently erases all the data in the record. Any data stored in the
Clipboard before you choose Edit>>Clear Form remains intact.

How to Display a Blank Record
1. Choose Edit>>Clear Form. DataEase displays a blank record. Any data stored in the
Clipboard before you choose Edit>>Clear Form remains intact.
Note: You only need to use this option if the Document Properties setting Clear form after
save is turned off.

How to Clear QBF Criteria
1. Choose Query>>Select Records or Query>>Sort Records. DataEase displays the current
QBF selection criteria or sort order.
2. Choose Edit>>Clear Form. DataEase erases all the selection criteria or sort order
information and displays a blank form.
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Saving a Modified Record
When you choose Edit>>Save, DataEase overwrites the values in an existing record with the
values that are currently displayed (and saves any previously blank values as new).
Note: Edit>>Save can also be used to save a new record (it functions exactly like
Edit>>Save As New Record when used to save a record for the first time).

How Referential Integrity Works When You Modify Multiform Records
See DESIGNER GUIDE Chapter 8 for information on DataEase relationships and referential
integrity.
Referential integrity is a special relationship option that affects how records in a Multiform are
treated during record entry. In User View, when you modify a Match field value in the Main
form of a Multiform, the change may or may not be duplicated in related Subform records,
depending on which referential integrity option the designer asked DataEase to enforce.
The table below summarizes how DataEase enforces each of the three referential integrity
options.

Referential Integrity When Multiforms Are Modified
Referential Integrity
Option

Effect on Match Field in
Subform

Effect on Relationship

Cascade (Update)

Updated

Maintained

Null (Blank)

Made Null

Severed

Restrict (Don't Update)

Not Updated

Severed

DataEase automatically enforces referential integrity in Form View. In Table View, DataEase
automatically applies the Restrict option.
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How to Modify an Existing Record
1. Display the record you want to change as the current record.
2. Change one or more field values by typing the new value(s) over the existing value(s). If you
prefer, you can choose Edit>>Clear Field to clear a field and then enter the new value.
DataEase displays the record status as modified.
3. Choose Edit>>Save. DataEase saves the record as it is now displayed (overwriting the
previous version of the record).

How to Modify Records in Table View
1. With a form displayed in Table View, modify any value(s) in any displayed record(s).
2. DataEase displays each changed record's status as modified.
3. Choose Edit>>Save, DataEase overwrites the previously saved data with the new values.
4. To modify additional records, repeat steps 1 through 3.
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How to Modify Records in a Multiform
1. Display the Main form record that contains the data you want to change.
2. Modify the Main form record and/or any Subform record(s).
3. Choose Edit>>Save. DataEase overwrites the previously saved data with the new values in
the Main form record and all Subform records simultaneously.
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Saving a New Record
When you choose Edit>>Save As New Record, DataEase adds a new record to the
associated database table. DataEase will not create a new record if any Required Field is left
blank or the values in the Unique fields match those in an existing record.

How to Enter New Records
1. If DataEase displays a blank record, start with step 3. If DataEase displays an existing
record, choose Edit>>Save.
2. Choose Edit>>Clear Form. DataEase deletes all the data.
3. Enter the data in the record.
4. Choose Edit>>Save As New Record. DataEase saves the data you entered and leaves this
record displayed.

How to Enter a New Record Using Previously Entered Data
1. Choose Edit>>Save to make sure the record is saved.
2. Modify the record.
3. Choose Edit>>Save As New Record. DataEase creates a new record using the currently
displayed data.
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Deleting a Record
When you choose Edit>>Delete Record, DataEase marks a record to be deleted. When a
record is marked deleted, DataEase excludes the record from reports and does not display it
when you page through the records or use Query By Form. When DataEase reorganizes the
form, the record is permanently deleted (erased from disk).
If you delete a record in a form that defines or uses an SQL table, the foreign database engine
permanently deletes the record when you choose Edit>>Delete Record (you cannot recover
the record using Edit>>Restore Record).
If you delete a record in a Multiform, DataEase displays the Delete Record dialog, which asks
you to specify records to delete.

Delete Record Dialog Options
Main form (only) deletes the current Main form record. The related Subform records continue
to exist but are orphaned (i.e., they are no longer related to any Main form record).
Main form and its Subforms deletes the current Main form record and all Subform records.
Subform only deletes the current Subform record and leaves any other Subform records and
the Main form record intact. DataEase offers this option only when the cursor is in a Subform
record.
Subform and its Nested Subforms deletes the current Subform record and all Subform
records nested within it.

How Referential Integrity Works When You Delete Multiform Records
See DESIGNER GUIDE Chapter 8 for information on DataEase relationships and referential
integrity in a Client-server environment.
Referential integrity is a special relationship option that affects how records in a Multiform are
treated during record entry. In User View, when you delete a Main form record in a Multiform,
the related Subform records may or may not be deleted, depending on which referential
integrity option the designer asked DataEase to enforce.
The table below summarizes how DataEase enforces each of the three referential integrity
options available.
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Referential Integrity When Multiforms Are Deleted
Referential Integrity Option

Effect on Subform Records

Cascade (Update)

Deleted

Null (Blank)

Deleted

Restrict (Don't Update)

DataEase lets you specify which record(s) to delete
(as explained on the previous page).

DataEase automatically enforces the specified referential integrity option in Form View. In
Table View, DataEase automatically applies the Restrict option.

How to Delete a Record in Form View
1. Display the record you want to delete as the current record. Choose Edit>>Delete Record.
DataEase removes the record from the form and marks it deleted.
2. When you save changes or close the form, DataEase permanently deletes the record.

How to Delete a Record in Table View
1. Click on the record you want to delete. Choose Edit>>Delete Record. DataEase displays
the record status as deleted and shows the record in reverse colors.
2. When you choose Edit>>Save or Edit>>Save As New Record, DataEase removes the
record from the display.
3. To delete additional records, repeat steps 1 and 2.
4. When you save changes or close the form, DataEase permanently deletes the record.
Note: You can delete many records simultaneously by marking each one to be deleted and
then choosing Edit>>Delete Record.

How to Delete a Record in a Multiform
1. Display as the current record the Main form record that contains the data you want to delete.
Choose Edit>>Delete Record. DataEase displays the Delete Record dialog, which asks
you to specify exactly what you want to delete.
2. Select the correct option from the dialog. DataEase removes the specified record(s) from the
form and marks it deleted.
3. When you save changes or close the form, DataEase permanently deletes the record.
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Restoring a Deleted Record
When you choose Edit>>Restore Record, DataEase reverses the effect of the Delete Record
command in three situations:
• Abandons all unsaved changes made to an existing record.
• Recovers a Main form record that has been marked deleted and restores it in its original
(record order) position in the form.
• Recovers a deleted Subform record.
Note: You cannot restore a record deleted from a form that defines or uses an SQL table.

How to Abandon Changes Made to an Existing Record
1. At any time before you save the record, choose Edit>>Restore Record.
2. DataEase restores the record to the previously saved version.

How to Recover a Deleted Record in Form View
1. With the record you just deleted still displayed, choose Edit>>Restore Record.
2. DataEase restores the record to its original position in the form as an active record.

How to Recover a Deleted Record in Table View
1. Before a record marked as deleted has scrolled off the display or you erase it from disk by
choosing Edit>>Save Changes, choose Edit>>Restore Record.
2. DataEase restores the record to its original position in the form as an active record.

How to Recover a Deleted Subform Record
1. At any time before you save the Main form record, place the cursor in the Subform record
marked as deleted and choose Edit>>Restore Record.
2. DataEase restores the Subform record to its original position in the Subform.
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Editing OLE Links
See DESIGNER GUIDE Chapter 6 for information on creating an OLE object.
When you choose Edit>>Links, DataEase opens the Links dialog, which lets you view and
change the method of updating a link (automatic or manual), update a linked object, cancel a
link, or repair an active link.

Links Dialog Options
Links lists OLE connections to the active document. Each row indicates one link's server
application (e.g., Paint), filename (e.g., VOLLYBLL.PCX), and link update method (Manual or
Automatic).
Update tells DataEase which method to use when updating links. When you choose an option,
the update method changes for each link that is highlighted. Choose:
• Automatic to update the link information displayed in DataEase whenever a change is made
to the source file.
• Manual to update the information only when you click the Update Now button.
Tip: You can change, update, or cancel multiple links at the same time by selecting multiple
items in the Links list box.
Update Now updates information for highlighted links with current data from the source
application. This option is used with the Manual Link Update method.
Cancel Link permanently breaks the connection currently highlighted in the Links list box. The
link itself is removed from the Links list box and the linked object is changed to a static picture
that has no update capability.
Edit Link opens the Windows application that was used to create the object (e.g., Microsoft
Excel), so you can edit the original document. Clicking the Edit Link button is the same as
double-clicking an OLE object.
Change Link opens the Change Link dialog, which lets you repair a broken link when
DataEase cannot find the source file (e.g., if you move the source file or you change its name).
To change multiple links at the same time, all selected links must point to the same source file
in the Windows application DataEase is linked to (e.g., an Excel chart). Otherwise, the Change
Link button is grayed.
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Change Link Dialog Options
File Name lets you assign a new filename for the link.
List Files of Type lets you choose the program that created the linked file.
Directories tells DataEase which directory stores the linked object. To select a directory,
double-click on the name of the directory.
Drives tells DataEase which disk drive stores your application. To select a drive, click on the
drop-down arrow and then on the drive letter.

How to Change the Update Method for a Link
1. Choose Edit>>Links. DataEase displays the Links dialog.
2. Click on the link in the Links list box that you want to change. DataEase highlights the
selected link.
Click on one of the following:
•

Automatic to update the link information displayed in DataEase whenever a change is
made to the source file.

•

Manual to update the information only when you click the Update Now button.

3. Click Close to close the dialog.

How to Update a Manual Link
1. Choose Edit>>Links. DataEase displays the Links dialog.
2. Click on the link in the Links list box that you want to update. DataEase highlights the
selected link.
3. Click on the Update Now button. DataEase updates information for the highlighted link with
the current data from the source application.
4. Click Close to close the dialog.

How to Break a Link
1. Choose Edit>>Links. DataEase displays the Links dialog.
2. Click on the link in the Links list box that you want to delete. DataEase highlights the
selected link.
3. Click on the Cancel Link button. DataEase removes the selected link from the Links list box,
permanently breaks the connection from the original file, and changes the linked object in
the DataEase document to a static image (i.e., it cannot be modified).
4. Click Close to close the dialog.
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How to Repair a Broken Link
1. Choose Edit>>Links. DataEase displays the Links dialog.
2. Click on the link in the Links list box that you want to restore. DataEase highlights the
selected link.
3. Click on the Change Link button. DataEase displays the Change Link dialog.
4. Choose the drive, directory, type of file, and filename of the file that now contains the linked
information.
5. Click Close to close the dialog.
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Modifying OLE Objects
See DESIGNER GUIDE Chapter 6 for information on defining and modifying an OLE object's
attributes.
When you choose Edit>>Object, DataEase opens a cascade menu similar to the one shown
below.
When you select an OLE object in a document, DataEase inserts its name before Object in the
menu option name (e.g., Excel Chart Object, Excel Worksheet Object, Package Object, etc.).
The Object cascade menu displays a dialog that lets you modify the key attributes of an OLE
object if the Windows application you are copying the object from has this capability. The
options that the cascade menu displays vary according to the object. In most cases, Edit and
Display are the only choices. DataEase supplies the Display option for all OLE objects. Some
applications, such as Windows Object Packager, also support Play.
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Controlling Record Entry in a Multi-User Environment
See DESIGNER GUIDE Chapter 8 for information about System Administration.
See USER GUIDE Chapter 8 and DESIGNER GUIDE Appendix A for information on running
DataEase in a Client-server environment.
When you use DataEase in a network environment, multiple users can access the same data.
As you view data, other users may be modifying or deleting the same data. To preserve data
integrity and prevent multiple users from viewing or modifying the same records, the system
administrator defines default locking rules for the application in the Application Preferences
dialog.
These locking rules control how many users can simultaneously access a record or table. In
most cases, the default locking rules the system administrator chooses are sufficient for the
database. You should not try to override the default locking rules unless you are thoroughly
familiar with network environments.
When you choose Edit>>Multi-User Options, DataEase lets you override the default record
entry locking rules and refresh the screen for the document currently in use. DataEase
displays the Multi-User Options cascade menu shown below.

Multi-User Options Cascade Menu Options
All Record Access removes any record entry locks on a document. This option lets other
users view, modify, enter, or delete a record you are viewing. However, if you modify a record,
DataEase locks that record to prevent other users from modifying the same record. Other
users can view that record but cannot modify or delete the record until you release it.
Read Record Access places a shared lock on the records in a document. Other users can
view the record you are viewing but cannot modify the record until you release it.
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If a user tries to modify the record you are viewing, DataEase displays a Resource Conflict
message. When you release the record, DataEase updates the record with your changes and
displays a message that tells the user that they are not viewing the most current record.
Likewise, if you try to modify a record someone else is viewing, DataEase displays a Resource
Conflict message and does not let you modify the record until the other user releases it.
No Record Access places an exclusive lock on the records in a document. Other users
cannot access the record you are viewing. If a user tries to access the record you are viewing,
DataEase displays a Resource Conflict message. You cannot select this option while another
user is viewing the same record.
Note: To release a record press Edit>>Clear Form, Goto>>Next Record, or File>>Close.
The record access option you select applies only to your workstation.
Once you select a record access option, it stays in effect until you choose another option or
close the document.
When you view a Multiform, the locking rule only applies to the main table.
You can select Multi-User Options in Table View as well as in Form View. In Table View, the
record access options on the Multi-User Options cascade menu change from record access
restrictions to table access restrictions (see below).

All Table Access removes any record entry lock on the table. Other users can view, modify,
enter, or delete a record you are viewing. Multiple users can view the same records, but only
one user can modify a record at a time.
Read Table Access places a shared lock on the table. Other users can view the records you
are viewing but they cannot modify them. DataEase displays a Resource Conflict message if
another user tries to modify or delete a record you are viewing.
You cannot access a record in a table someone else is viewing. If you try to modify a record in
a table that someone else is viewing, DataEase displays a Resource Conflict message. You
can access the record when the other user closes the document.
You cannot select this option while another user is modifying a record in the table.
No Table Access places an exclusive lock on the table. While you are viewing the table, other
users cannot view, modify, or delete records in that table. Once you select this option,
DataEase displays a Resource Conflict message when any other user tries to access the
table. You cannot select this option while another user is viewing the table you are trying to
lock.
Refresh reads the current record from disk and displays it on screen. Because other users can
modify the record you are viewing, you may not be viewing the most current data. Use this
option to display the most current data on the screen. Refresh overwrites changes you made
to the record but have not saved to disk.
Continuous Refresh automatically refreshes the current record at the rate set in the Set
Refresh Time dialog (see below).
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If you choose Edit>>Multi-User Options>>Continuous Refresh while viewing records in Table
View, DataEase automatically refreshes all the records on screen at the interval you specify in
the Set Refresh Time dialog. If you switch to Form View, DataEase suspends continuous
refresh.
Note: If you choose Edit>>Multi-User Options>>Continuous Refresh while viewing records
in Table View, DataEase automatically refreshes all the records on screen at the interval you
specify in the Set Refresh Time dialog. If you switch to Form View, DataEase suspends
continuous refresh.
Note: When you enter or modify a record, DataEase locks the record and suspends
continuous refresh until you choose Edit>>Save As New Record or Edit>>Save.
DataEase also suspends continuous refresh when you choose Goto>>Related Form.
Continuous refresh is not turned back on when you return to the original document.
Set Refresh Time opens the Set Refresh Time dialog shown below.

Set Refresh Time Dialog Options
See DESIGNER GUIDE Chapter 8 for information on settng the default refresh interval.
Set Refresh Time in Seconds lets you change the time interval, in seconds, for continuous
refresh. You can increase the refresh interval to place less demand on the network. The
default interval is two seconds. DataEase does not let you enter a zero as the refresh interval.
Note: When you view a Multiform, the refresh option applies to the Subforms as well as the
Main form.

How to Regulate Record Access in a Multi-User Environment
1. Choose Edit>>Multi-User Options>>All Record Access to remove any record entry locks
on the document. Other users can view, modify, or delete the record(s) you are viewing.
2. Choose Edit>>Multi-User Options>>Read Record Access to place a shared lock on the
records in the document. Other users can view the record(s) you are viewing but cannot
modify or delete these records until you release them.
3. Choose Edit>>Multi-User Options>>No Record Access to place an exclusive lock on the
records in the document. Other users cannot view, modify, or delete any record you are
viewing.
If you follow the above steps in Table View, DataEase applies the locking rule to all records in
the table, not just the records you are viewing.
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How to Refresh the Current Record
1. Choose Edit>>Multi-User Options>>Refresh to update the record(s) on the screen with
the latest changes saved to disk.
2. Choose Edit>>Multi-User Options>>Continuous Refresh to automatically refresh the
record(s) on the screen every two seconds.
3. Choose Edit>>Multi-User Options>>Set Refresh Time to change the refresh interval.
Enter a number in the Set Refresh Time in Seconds box. DataEase refreshes the screen at
the interval you specify.
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Chapter 5 : The View Menu
Viewing Records
The options on the View menu are used to change how DataEase displays records, display or
hide the Toolbar and Status Bar, and display the SQL commands that DataEase sends to a
foreign database engine in a Client-server environment.
Each menu option is summarized on the next page and explained in detail on the following
pages.

Summary of View Menu Options
Menu
Option

Keyboard
Equivalent

Form

Alt + V, F

Display the document so that one record appears on the screen
at a time.

Table

Alt + V, T

Display the document in columnar format so that multiple
records appear on the screen simultaneously.

All Records

Alt + V, A

Display all records in the document, ignoring any Query By
Form (QBF) selection criteria.

Queried
Records

Alt + V, Q

Display only records that meet QBF selection criteria.

Zoom

Alt + V, Z

Open the Zoom cascade menu,, which lets you choose options
for enlarging or reducing your view of a document.

Toolbar

Alt + V, B

Display or hide the Toolbar.

Status Bar

Alt + V, S

Display or hide the Status Bar at the bottom of the active
window.

Catalog

Alt + V, C

Display or hide the Application Catalog,, which lists all the
foreign databases,, tables,, and documents in an application.

Generated
SQL

Alt + V, G

Display DataEase-generated SQL statements in a Client-server
environment.
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Viewing Single versus Multiple Records
The options in the first group on the View menu let you view either one record at a time (Form
View) or multiple records simultaneously (Table View).

When you choose View>>Form, DataEase displays only one record on screen at a time.

When you choose View>>Table, DataEase displays multiple records at once in a table. Each
row is one record and each column is a field on the form.

How to Switch between Form and Table View
1. Choose View>>Form to display records one at a time.
2. Choose View>>Table to display multiple records in a tabular format.
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Viewing Selected Records
See USER GUIDE Chapter 7 for information on Query By Form (QBF).
The options in the second group on the View menu let you view different sets of records. The
viewed set can include all records or queried records.
When you choose View>>All Records, DataEase displays all the records in the document.
When you choose View>>Queried Records, DataEase displays only the records that match
the specified QBF selection criteria.
In the example below, assume the QBF criterion is set to STATE = CA.
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How to View Selected Records
1. Choose View>>All Records to display all the records in a document, ignoring any specified
QBF criteria.
2. Choose View>>Queried Records to display only records that meet the specified QBF
criteria (e.g., STATE = CA).

How to Clear QBF Criteria
1. Choose Query>>Select Records. DataEase displays the current selection criteria.
2. Choose Edit>>Clear Form. DataEase displays a blank form.
3. Choose View>>All Records to display all the records in a document.
Note: When you choose View>>All Records, DataEase maintains any specified QBF criteria
in memory.
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Enlarging or Reducing the Window View
See USER GUIDE Chapter 3 for information about printing an enlarged or reduced view of a
document.
When you choose View>>Zoom, DataEase displays a cascade menu that lets you magnify or
reduce your view of the document in the active window.

The Zoom option lets you control the appearance of the document on the screen. To get a
closer look at one particular area in a document, you can zoom in (enlarge) your view of the
document on the screen. To get an overview of a document, you can zoom out (reduce) your
view of the document on the screen. Use Zoom options to:
• View or edit small text.
• Print an enlarged or reduced area of a document.
• View a multiscreen document on one screen.
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Zoom Cascade Menu Options
Normal (100%) displays a document in its original size. Use this option to return a document
to normal size after it has been magnified or reduced.
In by 150% magnifies a document to 1 times its current size.
Out by 67% reduces a document to of its current size.
DataEase displays the current Zoom Percentage in the Title Bar of the active window. If you
maximize a document, the Title Bar is not visible.
Fill Window resizes the document to fill the entire window.
Custom opens the Custom Zoom dialog shown below.

Custom Zoom Dialog Options
Magnification Options let you customize the magnification setting for the document. (See the
next page for examples of different settings.)
• Normal 100% displays the document in its original size.
• Previous displays the document in the previous zoom size. DataEase displays the previous
size next to this option. For example, if you view a document at 150 percent, then zoom in by
200 percent, DataEase resizes the document to the 150 percent size when you select this
option.
• Fill Window resizes the document to fill the entire window.
• Fill Across resizes the document to fill the width of the window.
• Fill Down resizes the document to fill the height of the window.
• Zoom In by 150% magnifies a document to 1 times its current size. This option also appears
on the Zoom cascade menu.
• Zoom Out by 67% reduces a document to of its current size. This option also appears on
the Zoom cascade menu.
• Custom Zoom By Percentage lets you resize the document to a percentage of its current
size. For example, if you enter 10, DataEase displays the document so that it is ten percent
of its current size.
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• Custom Zoom To Percentage lets you resize the document to a percentage of its original
size. Enter a percentage between 1 and 2000.
Zoom Default Options let you select a specific area to enlarge and change the default Zoom
percentages.
Use a Rectangle to select areas to enlarge: lets you select an area of the document to
enlarge. When you turn this feature on and choose Zoom In, DataEase displays a movable
black rectangle. Position the rectangle over the area of the document you want to enlarge and
click. The area you select appears in the active document window.
Change Zoom In Percentage: lets you enter a new default value for the Zoom In percentage
that appears on the Zoom cascade menu. The default is 150 percent.
Change Zoom Out Percentage: is automatically calculated as the inverse of the percentage
you enter in the Zoom In Percentage box. The value appears on the Zoom cascade menu as
the Zoom Out percentage. For example, if you enter 200 in the Change Zoom In Percentage
text box, DataEase changes the Change Zoom Out Percentage to 50.
Meaning of the latest selection click displays a Help message for each Custom Zoom dialog
control. When you click on an option, DataEase displays a description of the option.
Note: DataEase accurately displays documents in their original size (100 percent). If you
reduce your view to a small percentage or magnify your view to a large percentage, DataEase
may distort your view of the document.
When you use the Fill Window, Fill Across, or Fill Down options, DataEase proportionally
resizes the width and height of the document. For this reason, a short form may not fill the
entire window when you choose the Fill Window option.
If you use non-scaleable fonts in your documents, you may be unable to read the letters when
you reduce the document to a small percentage of its original size.
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Filling the Document Window
See DESIGNER GUIDE Chapter 7 for information about the Zoom to Fit Window option.
To have DataEase automatically fill the document window when you change the size of the
window, check the Zoom to Fit Window option on the Document Properties dialog. When this
option is active, DataEase automatically resizes the document to fill the document window
each time you resize the window in User View.

How to Enlarge Your View of a Document
1. Choose View>>Zoom>>Zoom In by 150 percent. DataEase displays the document at 1
times its original size.
2. Choose View>>Zoom>>Normal to return the document to its original size.

How to Reduce Your View of a Document
1. Choose View>>Zoom>> Zoom Out by 67 percent. DataEase displays the document at of
its original size.
2. Choose View>> Zoom>> Normal to return the document to its original size.
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How to Select an Area to View Using Zoom
1. Choose View>>Zoom>>Custom. DataEase displays the Custom Zoom dialog.
2. Check the Use Rectangle option.
3. Click OK to close the dialog.
4. Position the rectangle over the area in the document you want to enlarge and click. The area
you select appears in the top left corner of the window.

How to Change the Magnification Options on the Zoom Menu
1. Choose View>>Zoom>>Custom. DataEase opens the Custom Zoom dialog.
2. Under Options, enter a percentage in the Change Zoom In Percentage box.
3. Click OK to close the dialog. DataEase displays this value in the cascade menu and
automatically calculates a new percentage to display as the Zoom Out percentage.
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Displaying the Toolbar
When you choose View>>Toolbar, DataEase displays the Toolbar below the Menu Bar. The
Toolbar is the row of buttons that give you quick access to frequently used commands.
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Displaying the Status Bar
When you choose View>>Status Bar, DataEase displays the Status Bar at the bottom of the
Application window. The Status Bar provides information about the system (such as whether
the Insert, Num Lock, and Caps Lock keys are active) or about the currently selected object
(such as its length, width, and location).
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Displaying the Application Catalog
When you choose View>>Catalog, DataEase turns the Application Catalog Window on or off.
DataEase reduces any open document window to its default size and displays the Application
Catalog Window at the left of the screen.
The Application Catalog Window lists all the foreign databases, tables, and documents in an
application. DataEase automatically updates the Application Catalog when you add, rename,
or delete documents and database links.

Viewing a Catalog List
By default, DataEase displays the table icon but not the list of tables in the application. To view
the list of tables, double-click on the table icon.
By default, DataEase displays lists of the documents (i.e., menus, forms, reports, and
procedures) in the application. To collapse a list, double-click on the document type icon.

Opening a Document or Table
DataEase lets you open a document or table directly from the Application Catalog. To open a
document or table, simply double-click on its name, or highlight its name and then click the
Designer or User View button on the Toolbar. DataEase displays the document or table in
User View by default.
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Note: In the Application Catalog, DataEase lists the Link Name for a foreign database instead
of the name used on the server. DataEase displays the foreign database names without
showing the associated list of tables. To view a list of the tables, double-click on the database
name.
Note: The Application Designer can use Application>>Preferences to set the Catalog lists to
appear collapsed when you open an application.

Viewing Status Information
See USER GUIDE Chapter 8 for information on linking an application to a foreign database on
a server.
The Application Catalog contains detailed status information you can view by enlarging the
window.
For each document, DataEase displays the:
• Name of the primary table (for a form or report only).
• Date when the document was last modified.
• User Name of the user who last modified the document.
Note: For each linked database, DataEase displays the:
• Server name or directory (with the name used to refer to the foreign database on the server
in quotes).
• Database engine type.
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Displaying SQL Statements
See DESIGNER GUIDE Chapter 8 for information on the Application Preferences option that
toggles this feature on and off.
When you choose View>>Generated SQL, DataEase displays the automatically generated
SQL statements that correspond to the current operation. For example, DataEase
automatically generates SQL statements when you insert, update, or delete a record, or create
or modify a table.
DataEase only displays the Generated SQL option when the program is running in a Clientserver environment.

How to Display SQL Statements
1. Choose View>>Generated SQL. Each time you perform an action, DataEase displays the
corresponding SQL statement in an SQL Syntax dialog in the middle of the active window.
Click OK to close the SQL Syntax dialog.
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Chapter 6 : The Goto Menu
Browsing through Records and Navigating Relationships
The options on the Goto menu are used to browse through records in the current form or
report, display the records in a related form, and retrieve data stored in a related form.
Each menu option is summarized on the next page and explained in detail on the following
pages.
Two buttons on the User Toolbar, Previous Data Page and Next Data Page, are used to
browse through records but do not have a corresponding option on the Goto menu. In Table
View, the Previous Data Page button scrolls the records one full screen up, while the Next
Data Page button scrolls the records one full screen down. In Form View, the Previous Data
Page button displays the previous record, while the Next Data Page button displays the next
record.

Summary of Goto Menu Options
Menu
Option

Keyboard
Equivalent

First
Record

Alt + G, F

Display the first record in the document.

Previous
Record

Alt + G, P Shift + F3

Display the previous record in the document.

Next
Record

Alt + G, N F3

Display the next record in the document.

Last
Record

Alt + G, L

Display the last record in the document.

Related
Form

Alt + G, R F10

Access a form that is related to the active form.

Return to

Alt + G, T Shift + F10

Close the current form and return to the form displayed
immediately before the current (related) form.

Lookup

Alt + G, K Ctrl + F10

Look up one value from a related form and insert all Match field
values in the current form.

Return
Data to

Alt + G, D Ctrl + D

Go to a related form, find a record, and return all Match field
values to the original record.
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Viewing Records in Sequence
See DESIGNER GUIDE Appendix B for information on DataEase (Native) and SQL forms.
The first group of options on the Goto menu lets you move from one record to another in Form
View.
When you choose Goto>>First Record DataEase displays the first record in the
document.
When you choose Goto>>Previous Record DataEase displays the record preceding
the one you are currently viewing.
When you choose Goto>>Next Record DataEase displays the record following the
one you are currently viewing.
When you choose Goto>>Last Record DataEase displays the last record in the
document.

Record Order
By default, records in a DataEase (Native) form are displayed in the order they are entered.
Records in an SQL form are displayed in order by Unique key (e.g., MEMBER ID).
Notice in the example illustration below that the DATAEASE records are displayed in an
apparently random order - in actual fact, the order they were entered into the computer. The
SQL records, however, are displayed sequentially in order of MEMBER ID number
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Viewing Records in a Related Form
When you choose Goto>>Related Form, DataEase displays the Related Form dialog, which
lets you open a form related to the currently active form. This option is available when you are
viewing a form or a live report.

When you choose Goto>>Return to, DataEase closes the current form and returns to the
form DataEase displayed immediately before displaying the current (related) form. When you
display a related form, DataEase places the name of the original form next to this option on the
menu (e.g., Return to MEMBERS).
If you use Goto>>Related Form to navigate from MEMBERS to FAMILY MEMBERS, you can
quickly return to the MEMBERS form using the Goto>>Return to option.

How to Open a Related Form
1. Choose Goto>>Related Form. DataEase opens the Related Form dialog.
2. Choose a related form from the list in the center of the dialog.
3. Click OK. DataEase opens the selected form and displays the first record related to the
record you were viewing in step 1.

How to Return to the Previous Form
1. Choose Goto>>Return to.
2. DataEase automatically closes the current form and returns to the previously active form (the
form you were viewing immediately before the current one).
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Retrieving Data from a Related Form
When you choose Goto>>Lookup, DataEase lets you look up one value from a related form
and insert all Match field values in the current form. DataEase also fills any field that contains
the word lookup in its Derivation Formula.
The example below shows how to enter related data from the FAMILY MEMBERS form in the
RESERVATIONS form when Ken Edwards calls to make a reservation at Playa Blanca.
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How to Perform a Lookup
1. Place the cursor in the field you want to look up. To limit the number of related records
DataEase retrieves, you can enter a partial value and a wild card character. For example, to
limit the records retrieved to last names that begin with S, type S* in the LAST NAME field.
2. Choose Goto>>Lookup and then choose the form you want to retrieve data from in the list
displayed in the Related Forms dialog. DataEase opens a window that displays a Table
View of the related records.
3. Double-click on the record that contains the value you want or highlight it and click OK.
DataEase fills in the lookup value from the related record as well as any values derived from
that value.
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Returning Data after Viewing a Related Form
When you choose Goto>>Return Data to, DataEase fills in all Match fields in the current
record with the values from a selected record in a related form. This option lets you display a
related form in Form View or Table View, search for related records using selection criteria and
wild cards in one or more fields, and return values for all the Match fields in the original record.

How to Return Data after Viewing a Related Form
1. Choose Goto>>Related Form. Choose the form you want from the Related Form dialog.
2. Find the record you need in Form View or Table View by entering QBF criteria, using wild
card characters, or by paging through the records.
3. Choose Goto>>Return Data to. DataEase displays your original form, automatically fills in
all Match field values, and calculates all derived values based on the returned data.
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Chapter 7 : The Query Menu
Selecting, Searching, and Sorting Records
The Query menu options are used to select sets of records, search for specific records, and/or
display records in an order other than the order in which they are stored in the current
document.
The easiest way to search for records is to use DataEase's Query By Form (QBF) facility. QBF
lets you find a record by simply entering sample data (called selection criteria) into a record
entry form. DataEase then compares the selection criteria with the values stored in each
record and retrieves only those that contain field values that match your sample data (e.g., if
you enter CA in the STATE field on the MEMBERS form, DataEase retrieves only members
who live in California).
Each menu option is summarized on the next page and explained in detail on the following
pages.

Summary of Query Menu Options
Menu
Option

Toolbar
Icon

Keyboard
Equivalent

Menu Option
Is Used to...

Select
Records

Alt + Q, S Alt +
F5

Enter sample data in one or more fields
indicating to DataEase which records to
retrieve.

Sort
Records

Alt + Q, R

Enter a number in one or more fields
indicating to DataEase in what order the
retrieved records should be displayed.
DataEase sorts records in ascending or
descending order based on the value in
each Sort field.

Ascending

Alt + Q, A

Order the records in the form from lowest
to highest value (AZ, 09) based on the
value in the selected Sort field

Descending

Alt + Q, D

Order the records in the form from highest
to lowest value (ZA, 90) based on the value
in the selected Sort field

Selection
Filter

Alt + Q, F

Display the selection criteria as a DQL
expression. If you're familiar with DQL, you
can freely edit this expression. Otherwise,
use the Expression Builder to build your
DQL expression

QBM New
Report

Alt + Q, Q F9

Create a report using the Query By Model
dialog.
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What's a Query?
See DESIGNER GUIDE Chapter 7 for information on using QBM and the Query By Model
dialog to select records.
See DQL Guide for information on using the DataEase Query Language.
See USER GUIDE Chapter 5 for more information on viewing selected records.
A query is an expression that tells DataEase to retrieve a specific set of records based on the
values in one or more fields. DataEase provides three different ways to define a query: Query
By Form (QBF), Query By Model (QBM), and the DataEase Query Language (DQL).
See the section, DQL Expressions as Selection Criteria: Examples, later in this chapter for
examples of DQL expressions that you can enter as selection criteria in a record entry field or
in the Record Selection Filter dialog.
Note: After DataEase retrieves the records requested by a query, you can print the output as
a report.
QBF lets you enter selection criteria directly in a record entry form to select, sort, and view
records in that form.
QBM lets you specify selection criteria graphically, using the Query By Model dialog to select
rows and columns from multiple database tables, group and sort the data, compute statistics,
create virtual fields, and create a report layout for the output.
DQL expressions let you enter sophisticated selection criteria syntactically in the DataEase
Query Language.
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Selecting Records
When you choose Query>>Select Records, DataEase displays a blank record in which you
can enter selection criteria.
The example below shows how to use Query By Form to select records from the MEMBERS
form and view the records DataEase finds as a result of the query.
In this example, the Sales Manager at Club ParaDEASE wants to view the members who live
in California.

Note: DataEase is case-insensitive (it does not differentiate between upper and lower case)
when performing a search. For example, DataEase finds all the members who live in California
regardless of whether you enter CA, ca, or Ca, as the selection criteria.
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How to Select Records
1. Choose Query>>Select Records. DataEase displays a blank form.
2. Enter your selection criteria in one or more fields. The criteria indicate which records to
retrieve.
3. To view the first matching record, choose Goto>>First Record.

Using Multiple Values in Selection Criteria
DataEase can also find records that contain a value within a range of values specified in the
selection criteria. For example, if you enter between 90020 to 90189 in the ZIP CODE field,
DataEase finds all the MEMBERS records that have a zip code from 90020 to 90189.
Using Multiple Criteria in One Field
You can insert two or more values as selection criteria in a field using the or DQL operator to
link the values. The or operator retrieves records that satisfy any of the selection criteria. For
example, if the criteria in the MEMBERS FIRST NAME field are "Andrew" or First
Name="John", DataEase finds all the members whose first name is Andrew or John.
Although, the syntax would be correct if the and operator was substituted for or, DataEase
would retrieve no records because no member has two first names. You can use the and
operator to find all the members whose first name is Andrew or John and whose last name is
Smith. For example, if the criteria in the MEMBERS FIRSTNAME field are, "Andrew" or First
Name="John" and LastName="Smith", DataEase finds all the members whose first name is
Andrew or John and whose last name is Smith.
When you use two or more values in your selection criteria, you must enclose the value in
quotation marks, as shown in the above examples.

Using Wild Card Characters in Selection Criteria
DataEase lets you search for a record using three special characters, called wild cards. If you
are not sure of the value in the record(s) you are searching for, you can enter any combination
of wild card characters (*, ?, and ~) as part of the selection criteria. The results of various wild
card searches are shown in the table on the next page.
* Wild Card replaces none, one, or a string of unknown characters. You can use the * wild
card twice in a field.
? Wild Card replaces one unknown character in a specific position.
~Wild Card (Soundex Search) finds records based on what a field sounds like, not on how it
is spelled. A Soundex Search finds patterns of consonants; it ignores the vowels in the word.
For example, if you enter ~Read as selection criteria in the MEMBERS LAST NAME field,
DataEase finds members such as Reed, Rhode, Rada, and Ride.
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The table below lists examples of wild card searches.
MEMBERS Records Retrieved when various Wild Card Characters are used in Search
Criteria
Value Entered in
the CITY Field

DataEase Retrieves Records with
the Following Values in the CITY Field

N*

New York, Newark, Nanuet, New Haven

*K

New York, Newark, York

*York

New York, York

new*

New York, Newark, New Haven

*nu*

Nanuet

*N

New Haven, Avon

*N*

New York, Newark, Nanuet, New Haven,
Avon

New??k

Newark

?ew*

New York, Newark, New Haven

~VN

Avon

*~VN

New Haven, Avon

?ew ~VN

New Haven
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How to Find a Record When You Don't Know the Exact Value
You're Looking for
1. Choose Query>>Select Records. DataEase displays a blank form.
2. Enter the selection criteria in the fields. Use an asterisk (*) to replace any part of the text that
you are unsure of. Use a question mark (?) to replace a single character you are unsure of.
You can use the * or ? wild card characters anywhere in a field value.
3. To view the selected records, choose View>>Table. To view just the first selected record,
choose Goto>>First Record.
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How to Find a Record When You Only Know What the Data
Sounds Like
1. Choose Query>>Select Records. DataEase displays a blank form.
2. Enter the selection criteria in the fields. If you search with multiple words in a field, do not
skip words. Enter the Soundex character (~) followed by the word(s) that sound like the data
in the record you are trying to find (e.g., to find Jon Smyth's record enter ~jn smth in the
NAME field). If you don't know where the word you are searching for occurs in the field, start
the search with the asterisk wild card character (e.g., if you are not sure where Smyth
appears in the field, enter * ~smth).
3. To view the selected records, choose View>>Table. To view just the first selected record,
choose Goto>>First Record.

© DataEase International Ltd

160

Searching for a Record in a Multiform
DataEase QBF can also be used to search for records in a Multiform.
If you enter selection criteria in one or more fields in the Main form or the Subform, DataEase
finds all the Main form records that match the criteria.
To search for a specific Subform record, you must enter the selection criteria using the fifth
option on the Query menu, Query>>Selection Filter.

How to Find a Main Form Record in a Multiform by Specifying Criteria in
the Main Form
1. Choose Query>>Select Records.
2. Enter your selection criteria in one or more fields in the Main form.
3. To view the selected records, choose View>>Table. To view just the first selected record,
choose Goto>>First Record. To view additional records, choose Goto>>Next Record.
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Displaying Sorted Records
When you choose Query>>Sort Records, DataEase displays records in a sequence based on
the value stored in one or more Sort fields. To specify a Sort field, click on a field with the
mouse.
DataEase inserts a number that indicates the sort level (1 = first Sort field, 2 = second Sort
field, etc.). DataEase lets you sort records on any number of levels (e.g., you can sort the
MEMBERS records first by STATE, then by ZIP CODE, and finally, by LAST NAME).

If you do not specify sort criteria when you perform a query, DataEase displays the records in
the order they were entered.
Note: If you do not specify sort criteria when you perform a query, DataEase displays the
records in the order of the Unique key.
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Specifying Sort Criteria
When you choose Query>>Ascending, DataEase displays the selected records in sequence
from lowest to highest value in the specified Sort field (e.g., A-Z, 0-9).

When you choose Query>>Descending, DataEase displays the selected records in sequence
from highest to lowest value in the specified Sort field (e.g., Z-A, 9-0).

How to Specify Sort Criteria
1. Choose Query>>Sort Records. DataEase displays a blank form.
2. Choose a sort order:
Choose Query>>Ascending to display records from the lowest to highest value in the
specified Sort field.
Choose Query>>Descending to display records from the highest to lowest value in the
specified Sort field.
3. To choose a Sort field, click on the field or press the Spacebar when the cursor is in the field
(e.g., when sorting by LAST NAME, DataEase displays a 1 in the LAST NAME field to show
it is the first sort level).
4. To sort records by additional fields, repeat steps 2 and 3 (e.g., when you sort records by
LAST NAME and then by FIRST NAME, DataEase displays a 2 in the FIRST NAME field to
show it is the second sort level).
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5. To modify the sort specifications, select a field, type a new sort level number, and insert (or
delete) a minus sign (-) to specify descending or ascending order.
6. To view the selected records, choose View>>Table. To view just the first record, choose
Goto>>First Record.

How DataEase Sorts Each Field Type
DataEase sorts each Field Type in a different manner. The table below summarizes the effect
of choosing Query>>Ascending or Query>>Descending for each Field Type.
Field Type

Ascending Order

Descending Order

Text

A ,B ,C, ... , X, Y, Z

Z, Y, X, ... , C,, B,, A

Numeric String

0, 1, 2, 3, 4, 5, ...

... , 5, 4, 3, 2, 1, 0,

Number

0, 1, 2, 3, 4, 5, ...

... , 5, 4, 3, 2, 1, 0,

Currency

..., $1.00, $1.01, $1.02, ...

... , $1.02, $1.01, $1.00,

Date

..., 1/1/92, 1/2/92, 1/3/92, ...

... , 1/3/92, 1/2/92, 1/1/92, ...

Time

00:00:01, 00:00:02, ...

... , 24:59:59, 24:59:58,

Sequenced ID

0000, 0001, 0002, 0003, ...

... , 0003, 0002, 0001, 0000

Yes/No

Yes, No

No, Yes

Choice

Bowling, Snorkeling, Tennis (order of
the choices as they appear in the list
box or radio buttons)

Tennis, Snorkeling, Bowling (reverse order
of the choices as they appear in the list box
or radio buttons)

Image

biker.pcx, golfer.pcx, skier.pcx
(alphabetic order of the image
filenames)

skier.pcx, golfer.pcx, biker.pcx (reverse
alphabetic order of the image filenames)

Combining Selection and Sort Criteria
DataEase can find records based on criteria entered in one or more fields and then sort the
records in the order you want.
For example, Club ParaDEASE sends a letter each quarter offering a special renewal rate to
each member whose membership expires in the next 90 days. To find these records, do the
following.
Choose Query>>Select Records and enter between 01/01/93 to 03/31/93 as the selection
criteria in the EXPIRATION DATE field.
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Choose Query>>Sort Records. Sort Results for Each Field Type
Choose Query>>Descending as the sort order and click on the CITY field. DataEase displays
a -1 in the field.
Choose Query>>Ascending as the sort order and click on the LAST NAME field. DataEase
displays a 2 in the field.
Choose Query>>Ascending as the sort order and click on the FIRST NAME field. DataEase
displays a 3 in the field.
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Using DQL to Select Records
See the DataEase Query Guide for more information on the DataEase Query Language.
When you choose Query>>Selection Filter, DataEase displays the Record Selection Filter
dialog, which displays QBF selection criteria. This dialog lets you enter selection criteria using
the DataEase Query Language (DQL) or use the Expression Builder to build a DQL
expression.
You can modify the criteria in the dialog by entering any valid DQL expression. If you know
DQL, you can manually write and edit a query in the Record Selection Filter box.
When you enter criteria using QBF and then view the criteria in the Record Selection Filter
dialog, DataEase adds an extra set of parentheses around each statement. If you enter criteria
directly in the dialog, you do not need to insert extra parentheses.

Record Selection Filter Dialog
Record Selection Filter Box displays the selection criteria for the currently active form.
Expression Builder displays the Selection Expression Builder dialog, which lets you choose
list box options to build a query. You can manually enter a DQL command in the dialog or
select a command from the Functions, Relationships, Columns, and Operators list boxes.
See the section, DQL Expressions as Selection Criteria: Examples, later in this chapter for
examples illustrating how to use DQL expressions in a query.
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Selection Expression Builder Dialog Options
Functions lists all the DQL commands, including predefined and Custom Defined Functions
and the relational statistical operators. Use the scroll bar to browse through the list of available
functions.
Relationships displays all the relationships for the active form, including the current
relationship, which provides access to system-defined variables such as current time, current
date, current user name, current computername, and current user level. This list box also
contains an option that lets you create a new relationship. Use the scroll bar to view all the
relationships.
Columns displays all the field names on the active form. If you select a relationship from the
Relationships list, the Columns list displays the names of the fields in the related form. Use the
scroll bar to view all the column names.
Operators lists comparison operators, relational statistical operators, punctuation marks, and
wild card characters. Use the scroll bar to view all the operators.
Numeric Keypad, located next to the list box of operators, lets you enter numbers and
mathematical symbols into a DQL expression.
Build a Table Selection Filter displays the current DQL expression. You can type selection
criteria or modify the expression directly in this box.

How to Enter Selection Criteria Using DQL
1. With the form displayed in the active window, choose Query>>Selection Filter. DataEase
displays a dialog that contains any previously entered selection criteria.
2. Delete the criteria and then enter the new criteria directly in the Record Selection Filter Box
using any valid DQL expression. Click OK to close the Record Selection Filter dialog.
To use the Expression Builder, click on the Expression Builder button. DataEase displays the
Selection Expression Builder dialog, which also contains any previously entered selection
criteria. Delete the criteria and then build the DQL expression using the list boxes. Click OK to
close the Selection Expression Builder dialog. DataEase uses the new criteria to select
records.

How to View or Modify Selection Criteria
1. Choose Query>>Selection Filter, DataEase displays a dialog that contains any previously
entered selection criteria.
2. If the query is correct, click OK. If you want to change the selection criteria, enter the new
criteria directly in the box using any valid DQL expression. When you click OK, DataEase
uses the new criteria to find records.
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How to Print Selected Records
See USER GUIDE Chapter 3 for more information on printing records.
1. Select the records to print by choosing Query>>Select Records and/or Query>>Selection
Filter.
2. Choose File>>Print. DataEase displays the Print dialog.
3. Choose All Records as the Print Range and a destination for the print job: Printer, File, or
Window.
4. Click OK to close the dialog.

DQL Expressions as Selection Criteria: Examples
See the DataEase Query Language Guide for detailed information about the DataEase
Query Language.
The table below lists some examples illustrating how to use DQL expressions in a query. The
first column shows the DQL term or symbol. The second column shows how to enter the
operator or symbol in a QBF. The third column shows how to enter the equivalent DQL
expression in the Record Selection Filter dialog. The query results are shown in the last
column.

Using DQL to Select PRICES and MEMBERS Records
DQL
Term

Selection
Criteria in
Field

Query

Records

Definition

DataEase Selects

Select records with field value that matches specified character pattern
*

Cara*

CLUB = "Cara*"

PRICES records for Club Caravelle

?

Carav?lle

CLUB =
"Carav?lle"

PRICES records for Club Caravelle

~

~Carval

CLUB =
"~Carval"

PRICES records for Club Caravelle

Select records with a field value that falls within a specified numeric range
=

=1

DEPARTURE
ZONE = 1

PRICES records for DEPARTURE ZONE 1

>

>3

DEPARTURE
ZONE > 3

PRICES records for DEPARTURE ZONES 4
and 5

<

<3

DEPARTURE
ZONE < 3

PRICES records for DEPARTURE ZONES 1
and 2

>=

>= 3

DEPARTURE
ZONE >= 3

PRICES records for DEPARTURE ZONES 3,
4, and 5

<=

<=3

DEPARTURE
ZONE <= 3

PRICES records for DEPARTURE ZONES 1,
2, and 3

not=

not = 3

DEPARTURE
ZONE not = 3

PRICES records for DEPARTURE ZONES 1,
2, 4, and 5
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between ... to ...

between 2 to 4

DEPARTURE
ZONE between 2
to 4

PRICES records for DEPARTURE ZONES 2,
3, and 4

Select records with a field value that matches the value returned by a DQL expression
max

max(ADULT
PRICE)

PRICES record with the highest adult price

min

min(ADULT
PRICE)

PRICES record with the lowest adult price

firstw

firstw(CLUBNAM
E) = Playa

PRICES records for Club Playa Blanca

count of

count of FAMILY
MEMBERS > 0

MEMBERS records with at least one family
member

year

year(DATE OF
BIRTH)> 70

FAMILY MEMBERS records with a birthdate
after 1970

*

ADULT PRICE *
.40 > 500

PRICES records with a child's price less than
$500.00 (40% of the adult price)

Select records based on multiple conditions
or

1 or Departure
Zone = 2

DEPARTURE
ZONE = 1 or
Departure Zone
=2

PRICES records for DEPARTURE ZONE 1 as
well as all PRICES records for DEPARTURE
ZONE 2

and

Caravelle in
CLUB NAME
field and 1 or
Departure
Zone= 2 in the
ZONE field.

(CLUB NAME =
"Caravelle") AND
(DEPARTURE
ZONE = 1 or
Departure Zone
= 2)

PRICES records for Club Caravelle when
guest is traveling from either DEPARTURE
ZONE 1 or DEPARTURE ZONE 2

When parentheses are present, math operations are performed from the inside out.
The use of parentheses is especially important when combining selection criteria using the
and and or operators or when clarifying the order of evaluation of otherwise ambiguous
expressions and operations.
Without parentheses, the last example above is ambiguous. DataEase could interpret it as
PRICES records for Club Caravelle when a guest is traveling from DEPARTURE ZONE 1 and
all records for guests departing from DEPARTURE ZONE 2.
In the absence of parentheses, the default order of evaluation is: multiplication and division
operations, addition and subtraction operations, comparison operators (e.g., <, >=), and,
finally, and and or operators.
When operations of equal priority are involved, the expression is evaluated from left to right.
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Using a Query as the Basis for a Report
See DESIGNER GUIDE Chapter 3 for information on using Query By Model.
When you choose Query>>QBM New Report, DataEase passes any QBF selection
criteria to the Query By Model dialog. Choosing QBM lets you use the current form and
selection criteria as the basis for creating a new report with Query By Model.

Choosing Query>>QBM - New Report lets you:
• Use QBF to select data as the basis for the report.
• Omit one or more fields from the report.
• Add data from other related database tables.
• Create a custom layout for the report (QBF restricts you to the layout of the original form).
• Incorporate statistics (e.g., group totals and grand totals) into the report.
• Save the query for future use.

How to Create a QBM Report
1. Enter selection and sort criteria using any combination of Query menu options.
2. Choose Query>>QBM - New Report. DataEase displays the Query By Model dialog. Use
QBM to refine or expand the report definition.
3. Click OK. DataEase displays the Layout Options dialog, which lets you create a custom
layout for the document.
4. Click OK. DataEase displays the Print dialog.
5. Choose a Print Range and a destination for the print job: Printer, Window, or File.
See USER GUIDE Chapter 3 for information on printing a report.

© DataEase International Ltd

170

Chapter 8 : The Application Menu
Application Administration and Utilities
See DESIGNER GUIDE Chapter 8 for detailed information each option on the Application
menu.
The options on the Application menu are used to control access to the data and objects
managed by an application by defining each user's name, password, and security level,
defining relationships between database tables, registering Custom-Defined Functions (CDFs),
and linking external databases to the application.
Note: Many of the options on the Application menu are generally reserved for use by the
application designer or the system administrator. You must have a High Security Level to use
these options. For this reason, this chapter briefly summarizes the Application menu options.
See the Designer's Guide for complete information on these options.

Summary of Application Menu Options
Menu Option

Keyboard
Equivalent

Menu Option Is Used to...

Users

Alt + A, U

Give a new user access to the application by assigning him or her
a Name and Password.

Relationships

Alt + A, R

Define a relationship between database tables and maintain
existing relationships.

Custom Functions

Alt + A, F

Register a Custom-Defined Function with the application.

Database Links

Alt + A, D

Link an external database to an application.

Utilities

Alt + A, T

Reorganize the data in a table, backup an application, restore an
application, install documents in an application, lock an application.

Status

Alt + A, S

View reports that list the status of records, servers, documents, and
imports in the current application.

Preferences

Alt + A, P

Set up the application environment according to your preferences.
For example, you can set the Application Catalog to open
automatically when you sign on to the application.
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DataEase System Forms
When the application designer creates an application, DataEase automatically creates three
record entry forms that store the information DataEase needs to manage the data and objects
in the application.
The information that defines users, relationships, and custom functions is entered into System
forms the same way you enter data in a form you create with DataEase. Usually, the
application designer or an appointed system administrator performs this task.
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Chapter 9 : The Window Menu
Arranging Windows, Documents, and Icons
The Window menu options let you arrange document windows and icons on your screen and
close all currently open documents in one step.
The term document window refers to any window that contains a DataEase document, such
as a form or report.
Each menu option is summarized on the next page and explained in detail on the following
pages.

Summary of Window Menu Options
Menu Option

Keyboard
Equivalent

Menu Option is Used to...

Tile Across

Alt + W, A

Arrange document windows one next to the other.

Tile Down

Alt + W, D

Arrange document windows one above the other.

Cascade

Alt + W, C

Arrange document windows one in front of another with all the Title
Bars visible like the tabs on a group of file folders.

Arrange Icons

Alt + W, I

Align minimized windows in a row on the bottom of the DataEase
window.

Close All

Alt + W, L

Close all windows (except the Application Catalog) without exiting the
application.

1...9
Form Name

Alt + W, 1...9

Display the selected table or document in the active window.

© DataEase International Ltd

174

Arranging Windows and Icons
When you choose Window>>Tile Across, DataEase arranges the document windows one
adjacent to another.
When you choose Window>>Tile Down, DataEase arranges the document windows one
under the other.
When you choose Window>>Cascade, DataEase overlaps the document windows one in
front of another with each Title Bar visible and the active window displayed in front of all the
other windows.

When you choose Window>>Arrange Icons, DataEase aligns all the DataEase document
icons in a straight row at the bottom of the DataEase desktop.
When you click on a window's minimize button, it becomes an icon until you restore the
window by double-clicking on the icon.
When you choose Window>>Close All, DataEase closes all document windows (except the
Application Catalog) without closing your current application.
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Changing the Active Window
Document and Table Names appear at the bottom of the Window menu, one for each window
open in the DataEase desktop.
When you open a new document, DataEase automatically adds the name of the document to
the list at the bottom of the Window menu. Click on one of these names to activate the
corresponding window and bring it to the foreground. DataEase displays a checkmark next to
the name of the active document.
DataEase can list as many as nine open documents on the Window menu. If you open more
than nine windows, DataEase displays the first nine on the menu and an additional option,
More Windows, at the bottom of the Window menu.
When you choose Window>>More Windows, DataEase displays the Select Window dialog,
which lists all the open windows.
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Chapter 10 : The Help Menu
Accessing Online Help
The Help menu is the last menu on the Menu Bar. Whenever DataEase is running in the active
window and you select an option from the Help menu, Microsoft Windows activates the
DataEase Help system.
The DataEase Help system is a separate hypertext program that runs concurrently with
DataEase. The hypertext program runs in its own moveable, resizeable window and uses
many of the standard navigation tools the Microsoft Windows Help system provides.

This chapter explains how to use the Help menu options as well as the Microsoft Windows
Help system.
Each menu option is summarized on the next page and explained in detail on the following
pages.
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Summary of Help Menu Options
Menu
Option

Keyboard
Equivalent

Menu Option Is Used to...

Contents

Alt + H, C

Display DataEase Help topics in a navigation pane. Each topic is a jump
term that moves you to more specific information. Also provides basic
instructions on how to navigate through the Microsoft Windows Help
system.

Search

Alt + H, S

Display the Search Criteria dialog. Type a word or phrase in the text box or
select from the topic list. DataEase displays Help on the topic.

Desktop

Alt + H, D

Display accelerator keys for menu commands and mouse functions.

Menus

Alt + H, M

Display Help for each menu option.

Toolbar

Alt + H, T

Display Help for each Toolbar icon.

How to

Alt + H, H

Display an alphabetical list of common procedures.

Glossary

Alt + H, G

Display a pop-up definition when a term is selected.

User Help

Alt + H, U

Display the custom Help messages that the application designer creates for
documents and individual fields.

About
DataEase

Alt + H, A

Display the program version and copyright information.
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Accessing the Help Index
When you choose Help>>Contents, DataEase tells you how to use the Help system and lists
the major topics explained in on-line Help. Each topic on the list is a Jump term. To get help on
a specific topic, simply click on it.
To get more detailed instructions on using on-line Help once you are inside the Help system,
choose Help>>How to Use Help from the Menu Bar. DataEase displays detailed instructions
on how to navigate through Microsoft Windows Help systems.

Searching by Using a Keyword
When you click the Search tab, DataEase displays the Search Criteria dialog. Type a word or
phrase in the text box or select from the topic list. When you click Show Topics, DataEase lists
the topics found. When you select one and click Go To, DataEase displays Help on the topic.
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Accessing Online Help Topics
The options in the second group on the Help menu let you directly access major topics in online Help.
When you choose Help>>Desktop, DataEase provides information on each DataEase
function, accelerator, and navigation key.

When you choose Help>>Menus, DataEase provides information on each DataEase menu
option in User View and Designer View.
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When you choose Help>>Toolbar, DataEase explains the purpose of each button on the
Toolbar. Toolbar buttons typically allow quick access to the most commonly used functions.

When you choose Help>>How to, DataEase displays an alphabetical list of frequently used
procedures (such as How to Save a Form, How to Run a Report, etc.). To view the step-bystep instructions for a How to topic, simply click on it.
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When you choose Help>>Glossary, DataEase lists all important DataEase terms in
alphabetical order. To view the pop-up definition of a Glossary term, click on the term. When
you are finished, click the mouse button again to close the pop-up definition.
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Displaying Custom Help Messages
See DESIGNER GUIDE Chapters 6 and 7 for information on defining Field- and Documentlevel Help.
When you choose Help>>User Help, DataEase displays the User Help dialog. This dialog lets
you display custom Help messages created by the application designer.

User Help Dialog Options
Help Window displays a custom Help message for the current field or the entire document. If
no Help is defined for the document or field, DataEase displays <No Help>.
Help Display Options switch the message in the Help window between Field- and Documentlevel Help.
• Field Help displays the Field-level Help the application designer defined in the Field
Definition dialog. If Field-level Help is defined, DataEase initially displays it in the Help
Window when you open this dialog.
• Form Help displays the Document-level Help the application designer defined in the
Document Properties dialog.

How to Display Field or Document Level Help
1. Choose Help>>User Help. DataEase displays the User Help dialog.
2. Click Field Help to display Field-level Help or click Form Help to display Document-level
Help.
3. Click OK to close the dialog.
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Finding Your Version Number
When you choose Help>>About DataEase, DataEase displays the DataEase version number,
copyright information, your serial number, and the number of users licensed to access
DataEase.
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Navigating Online Help
This section explains how to use several important Windows Help features. For more
information on Windows Help controls, refer to your Microsoft Windows documentation.

Jump Term
Jump term is a cross-reference that connects the current topic to other Help topics. When you
click on an underlined Jump term, DataEase jumps to a related topic without returning to the
Index. Jump terms move you from general to more specific help (see below).
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Glossary Term
Glossary term is a dotted underlined word or phrase that displays a pop-up definition when you
click on it (see below). Click the mouse button again to close the pop-up definition.

Help Function Buttons
Whenever DataEase displays the Main Index or a specific Help topic, Windows activates the
five special Help navigation buttons to help you navigate from one topic to another. The use of
each of these buttons is explained below.

Contents lists all DataEase Help topics in alphabetical order. To display the list of Help topics,
simply click on the Contents button. Each topic on this list is a Jump term. To get help on a
specific topic, simply click on it.
Search lists the words and phrases you can use to search for topics in the DataEase Help
system. When you enter or select one of these words or phrases, you can go to a specific Help
topic.
Back displays the previous Help screen. This button lets you trace your steps backwards
through your Help session. Each time you select Back, DataEase displays the Help screen
accessed just prior to the one you are now viewing.
Browse Forward displays the next Help topic in a series of related topics. To look at the next
topic in a series of related topics, simply click Browse Forward.
Browse Back displays the previous topic in a series of related topics. To look at the topic you
viewed just prior to the one on screen, simply click Browse Back.
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On-line Help Menus
The menus inside the DataEase Help window let you print, add notes to, and place bookmarks
on Help topics. Specific menu options are briefly explained below.
When you choose File>>Print Topic, DataEase prints a copy of the topic and displays a dialog
that lets you cancel the print job.
To print a topic, you must first define your printer using Printer Setup on the File menu.
When you choose Edit>>Annotate, DataEase displays a small empty window with the cursor
blinking in the upper left corner. This option lets you add your own notes to a topic for future
reference. Simply type your note and click OK.
When you select the topic again, DataEase displays a paper clip to the left of the topic title. To
display your note, click on the paper clip. You can edit or delete the note.

When you choose Bookmark>>Define, DataEase displays the Bookmark Define dialog, which
lets you mark a topic for quick future reference. Accept the default topic name or type a new
one and click OK. DataEase adds the topic to the end of the Bookmark menu.
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Appendic A : Setup
Installing DataEase
The DataEase 6 Installation dialog, shown below, allows you to Install DataEase and
WebPublisher. It also allows you to Check or Change your Network Locking system.

Multi-User Applications
In earlier versions of DataEase, there were two ways in which a networked DataEase
application could be accessed.
1. By individual copies of DataEase held on individual workstations
2. By a single multi-user copy of DataEase held on a Server. (The 'user count' of the multi-user
copy of DataEase was incremented by the purchase of additional Server Access Packs).
In DataEase 6, option 2 has been dropped. Option 1 - individual copies of DataEase held on
each workstation - is the only way to access shared applications.

File Paths
Previous versions of DataEase have allowed users to simply copy DataEase system files from
one directory to another. However, this is not a safe or satisfactory way of moving program
files, since it ignores the Operating System's Registry settings and Environment Variables.
In DataEase 6, you should use the Install program if you need to change your DataEase
program directory. The Install program will take care of such things as Environment Variables
automatically.
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Operating Systems
Before the release of version 5.5 and 6.0, DataEase was sold in two variants - one for NT, and
another for Windows 3.x/ 95 and 98.
DataEase 5.5 was supplied in a single variant, which supported Windows 95, 98, NT and
2000. The old Windows 3 operating system was not supported.
DataEase 6 is sold in a single variant, which supports Windows 98, NT, XP and 2000.
Windows 3 and Windows 95 are NOT supported.
Whereas DataEase 5.5 (and earlier versions) were 16 Bit products, DataEase 6.0 is a full 32
Bit product.

Multiple Sessions
DataEase will run in multiple sessions under NT. To enable this, the "Run in Separate Memory
Space" Windows NT property must be set in each session. Additionally, a separate DENAME
is required for each session. (NT and Windows 2000 allow multiple Users per machine, and
each user is allowed his own set of Environment Variables. Hence it is simple to assign a
separate DENAME to each user. In Windows 98, you can achieve the same result by using
Batch files to change the DENAME name).

Shared Applications
If you intend to share a local application (i.e. an application held on your local workstation,
rather than a network server), then you must set the SHAREDLOCALDATABASE=YES in the
PRISM.INI file. DataEase must be configured as Networked (not standalone) and you must
specify both DENAME and DEPATH parameters.
The screenshot pictured below shows you how to make the SHAREDLOCALDATABASE=YES
entry in PRISM.INI.

PRISM.INI is a simple text file. You can edit it with NotePad or WordPad. Before you start
editing the file - make a copy of it. Just in case you want to revert to the original.
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Interoperability
DataEase 6 introduces a completely new 32 Bit Network Locking scheme. This scheme is
NOT interoperable with earlier 16 Bit copies of DataEase. You must NOT attempt to
interoperate DataEase 6 and earlier versions of DataEase against the same application. If you
do so, your network locking, and hence your data integrity, will be at risk.

Locking Configuration
Earlier versions of DataEase used a Network Locking scheme which contained Assembler
Language routines making direct DOS calls. This system - powerful and flexible in its time - is
now obsolete. Modern 32 Bit operating Systems are rigorous in their control of the PC, and
emphatically disapprove of programs attempting to bypass them by making direct calls.
DataEase 6 replaces the old Network Options - Novell/ MS-DOS/LAN Manager, etc - with
three new Locking Configuration Types, all of which are fully 32 Bit compliant.

Basic
A basic implementation of locking, which works with both Advisory and Non-Advisory
networks. It provides replication in data-entry, and allows configurable locking for Record
Entry, Reporting, and Procedures. Both Shared and Exclusive locks are supported. This option
should be suitable for all networks.

Full
This option requires an Advisory Network, such as Novell Netware or Windows NT Server. It
provides all the facilities listed under "Basic", with the bonus of improved performance. This
offers superior performance to the 'basic' option. Your network must support Advisory
Locking if you wish to use this option. Novell and NT Server are two examples of such
networks.

Opportunistic
A non-locking approach, similar to that of Microsoft Access. Data replication during data entry
is provided, but there is no locking. This option will work on any network, and actually provides
very fast performance on some applications - for example, those with lots of 'new' data entry
work, with little data modification. It works badly on applications where records are subject to
frequent modification, since roll-backs are time consuming and annoying to the operator.
Important: If this option is used, then it is ESSENTIAL that only one user runs data-modifying
procedures at any one time. This can be achieved in various ways - menu/user security
restrictions, locking the database, and so on.

© DataEase International Ltd

191

Selecting your Locking Configuration
The new Locking Configuration dialog is pictured below. To reach this dialog, run the
DataEase Setup Program, and select the option "Change Network Type".

Stand-alone Application Locking
In previous versions of DataEase it has only been possible to Lock a networked copy of
DataEase. This facility has now been extended to include stand-alone copies of DataEase - in
other words, copies of DataEase where the Network Locking type has been set to None.
This enables a user to lock an application before starting some sensitive task - such as a
lengthy update procedure - and thus eliminate the possibility of either;
1. The application being accessed by another session on the same machine, or;
2. The application being accessed by another PC, via a shared drive.
To lock the application, select Application>>Utilities>>Lock.
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Appendix B : Client-Server Applications
Accessing Foreign Databases
See DESIGNER GUIDE Appendix A for information on creating tables in a foreign database.
This appendix provides an overview of using DataEase in a Client-server environment.
Detailed information about each topic mentioned in this appendix can be found either in the
User's Guide or Designer's Guide provided with your software or in the specific Database
Engine Information Guide.
DataEase makes it easy to access data stored in SQL tables and other popular data formats
such as Microsoft/Sybase SQL Server, Oracle Server, IBM DB2, or Access.
In User View, you can interact with foreign data in easy-to-use DataEase forms and reports at
a PC while the database engine stores and processes the data. The database table(s) and
application references may reside on multiple database servers, even servers of different
database engine types. Using ODBC links, DataEase transparently accesses information in
various tables on multiple servers-you don't need to know the actual location of the tables.
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Client-Server Terms
The table below summarizes some special terms used in the documentation related to running
DataEase in a Client-server environment.

DataEase ClientServer Terms
SQL Term

Definition

Application

A collection of forms, reports, menus, and data that solves a particular business
problem.

Column

The vertical component of a table. A column is equivalent to a field on a DataEase
form.

Database

A collection of related tables containing data and the definitions of database objects.

Database Engine

A multi-user relational database system employing Client-server architecture and
used for data storage, retrieval, and transaction processing. Also called a foreign
engine.

Database Server

A host computer with a multi-tasking operating system, connected to other
computers though a network, running database engine software.

Native DataEase
Engine

DataEase's built-in multi-user relational database system. It is used for data
storage, retrieval, and transaction processing employing Native tables located on a
local drive or network file server.

Native Table

A collection of data records stored and maintained by the Native DataEase engine.

Permission

A server security measure that controls record entry functions on an SQL table.

Privilege

A server security measure that controls Form and Table definition functions in an
SQL database.

Row

The horizontal component of a table. A row is also referred to as a record in a
DataEase form.

SQL

Structured Query Language. A language used for defining, querying, modifying, and
controlling the data in a relational database.

SQL Database

A fixed amount of disk space on a database engine reserved for the exclusive use of
one or more applications.

SQL Table

A rectangular array of data values consisting of a specific number of columns (fields)
and any number of rows (records) in a database.

View

A subset or superset of one or more tables.
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User Privileges and Permissions
To perform record entry functions on a form that defines or uses a foreign table, you must have
the necessary access rights on the server. The two levels of server access rights are explained
in the table below.

User Privileges and Permissions
Security
Feature

SQL
Commands

Used to...

User Privileges

CREATE TABLE
DROP TABLE
UPDATE TABLE

Control table definition functions. Privileges are usually reserved
for the system administrator.

User
Permissions

SELECT
INSERT
UPDATE
DELETE

Control record entry functions on SQL tables. User permissions
can only be granted by the system administrator or the user who
originally created the table (the table owner). DataEase
automatically translates its user security levels into the
appropriate SQL User Permissions.

User privileges and permissions can be granted or revoked through an SQL program or utility
outside of DataEase, or through an exec SQL statement within the DataEase Query
Language. However, DataEase security levels can only be specified within DataEase.
Therefore, the SQL system administrator can revoke user permissions on the server without
changing a user's DataEase security level.
For example, if your UPDATE permission in a specific SQL table is revoked through SAF
(Server Administration Facility), you might not be aware of the change until you try to modify a
record in DataEase. Even though your DataEase security level may appear high enough to
modify records, the server will display an error message informing you that you are unable to
perform the requested action.
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Opening an Application
See USER GUIDE Chapter 1 for information on how to open an application.
The sign on process for DataEase is the same whether or not your application provides access
to a foreign engine. The first time you access the foreign engine, DataEase automatically tries
to log you on, using the same User Name and Password you enter to sign on to the
application. If your User Name and Password are not valid on the server, DataEase displays a
Foreign Engine Login Failure dialog:
If DataEase displays this dialog when you try to open a document, simply enter a valid User
Name and Password and click OK. If you haven't been assigned a valid User Name and
Password that lets you log on to the foreign database you need to access, see your system
administrator.
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Record Entry in a Client-Server Environment
See USER GUIDE Chapters 2 and 4 for information on entering, modifying, and deleting a
record.
Except as detailed in this appendix, you perform record entry functions in the same way as in
DataEase.

Types of Record Entry Forms
Because DataEase documents can access data stored in either a network or local directory or
in a foreign database, these documents are divided into two types:
•

Native DataEase form, which stores data on a local hard drive or a network file server.

•

A form that defines or uses a foreign table, which stores data on a foreign database
engine.

Several record entry functions (e.g., viewing, modifying, and deleting records) behave
differently, depending on the type of form you are using. The remainder of this chapter
explains the differences in record entry when you access a foreign database.
Note: DataEase reports can use Native and/or foreign data tables, but a report can never
define a table.

Record Entry Transactions
A transaction is any number of actions that maybe treated as an indivisible unit of work
performed on the data in an application. For example, a transaction might consist of the
procedures used to ensure that DataEase reserves lodging for every person entered in the
same record in the RESERVATIONS form.
When you perform record entry operations on a form that defines or uses a foreign table,
DataEase defines record entry transactions as explained below:
• If the form is not a Multiform, each record that is saved, modified, or deleted is treated as a
separate transaction.
• If the form is a Multiform, DataEase treats saving, modifying, or deleting a Main form record
and all its related Subform records as a single transaction.
Most SQL engines support a more advanced concept of transaction processing that
guarantees that the entire transaction is completed before it is committed. If any portion of the
transaction fails, the entire transaction is rolled back so that no data is changed.
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How DataEase Security Levels Affect Record Entry
See DESIGNER GUIDE Chapter 8 for more information on DataEase security levels.
To perform record entry operations on a form that defines or uses a foreign table, you must
have the required user permissions on the SQL table in addition to the appropriate DataEase
security level (see the table below).

SQL User Permissions Necessary to Perform Record Entry Functions
Record Entry
Function Permitted
by DataEase

SQL User Permission Required

View a Record

SELECT

Modify a Record

UPDATE

Enter a Record

INSERT

Delete a Record

DELETE

Use QBF or QBM

SELECT on all tables referenced by the query or report. You must also have a
valid User Name in all foreign databases where the tables used by the report are
stored.

Use DQL

SELECT, INSERT, UPDATE, and DELETE as required by the procedure on all
referenced tables. You must also have a valid User Name in all foreign databases
where the tables used by the procedure are stored.

Note: If you try to perform a record entry function (e.g., view, save, modify, or delete a record)
without the appropriate DataEase security level or SQL user permission, DataEase displays an
error message.
To run a procedure that installs an application, you must have CREATE TABLE privileges on
the server.
See your system administrator to obtain the required user permissions.
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How Field Characteristics Affect Record Entry
The table below summarizes how the field characteristics assigned to a field affect record entry
in a foreign table.

Record Entry and Field Characteristics
Field Type/

Effect When Data Are Stored in

Effect When Data Are Stored in

Characteristic

a Native Table

a Foreign Table

Text

Wild card (*,?, and ~) characters should
never be entered as data.

Wild card characters (*,?, and ~) are
acceptable data values in an SQL table.

Required

Data must be entered in all Required fields
to save a record

Data must be entered in all the NOT NULL
(Required) fields to save a record. When
you create a form over an existing table, all
NOT NULL columns in the database table
must be included in the form. See
Appendix A in the Designer's Guide.

Unique

The combined data in all Unique fields
cannot be duplicated in an existing record.
If DataEase finds a duplicate record, the
new record cannot be saved.

In an SQL table, records are stored in
order by the clustered index, which is
comprised of all the Unique fields.

Validation
Formula

When you choose Edit>>Save or
Edit>>Save As New Record on a record
with invalid values, DataEase displays an
error message. The value(s) must be
corrected before you can save or modify
the record.

A DataEase Validation Formula, which
restricts the values that you can enter into
a field to a specific range, is not enforced
by the server. If the data is modified by
another product, you may see values
displayed that violate the range limit.

Note: When you enter (or modify) a record in a form that defines or uses a foreign table, and
no Unique fields are defined on the form, the foreign engine is solely responsible for the way in
which records are ordered.
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Viewing Records
See DESIGNER GUIDE Chapter 7 for more information on Document Security.
See USER GUIDE Chapter 7 for information on selective searches.
If your View security level is too low or you do not have SELECT permission in the foreign
table, you can select a form from the Application Catalog. However, when you choose
View>>Next Record or View>>Table to view records, DataEase displays an error message,
and no records are displayed.
Should this occur, you must see your system administrator to obtain the necessary
permissions.

Searching for a Record
The time DataEase takes to find a record depends on the number of records and the number
of Indexed fields in the form. If you are using a form that defines or uses a foreign table, the
foreign engine performs the search. Because each database engine has its own searching
algorithms, the time required to find a record varies from engine to engine.
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Modifying a Record
See USER GUIDE Chapter 4 for more information on modifying records.
To modify a record in a form that defines or uses a foreign table, you must have UPDATE
permission in the table. You can only modify records in a form if the minimum DataEase
security level required to modify records on the Document Security dialog is set to your level or
lower.
When you choose Edit>>Save to modify a record in a form that defines or uses a foreign
table, DataEase updates the table row with the data saved in the record currently displayed on
the screen.
When you choose Edit>>Save to modify a record in a form that defines or uses a foreign table
and no Unique fields are defined on the form, DataEase displays an informational dialog box if
at least one record in the form is identical to the record on the screen.

Modifying a Record in Table View
When you modify records in Table View in a form that defines or uses a foreign table,
DataEase treats each record as a separate transaction, that is, each record is saved
individually. If DataEase cannot commit a record (e.g., the attempted action violates a serverspecified rule or you do not have the necessary server permission), no more records are saved
and DataEase displays an error message. All the records are saved up to, but not including,
the record that cannot be committed. You must return to the uncommitted record and choose
Edit>>Restore Record. Then choose Edit>>Save As New Record or Edit>>Save to save
the remaining records.

Modifying a Record in a Multiform
See DESIGNER GUIDE Chapter 8 for more information on referential integrity in Multiforms.
DataEase provides two special referential integrity options in the Relationships form: Server C
(Cascade) and Server SN (Set to Null). The options let you transfer the responsibility of
enforcing referential integrity to a foreign database engine.
By transferring responsibility for referential integrity to the server, referential integrity can be
ensured regardless of which client application is used to modify data. However, the integrity
rule must be recreated on the server or it will not be enforced. See your Database Engine
Guide for information on how to create rules and triggers.
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When you modify a Match field value in the Main form of a Multiform, the Match field in the
related Subform records may or may not be modified depending on the referential integrity
option defined in the Relationships form (see table below).

Server-Enforced Referential Integrity When a Record Is Modified in a
Multiform
Option

When You Modify a Record, DataEase...

Server C

Only modifies the record in the Main form and leaves the Subform records unmodified. The
foreign database engine is responsible for cascading changes.

Server SN

Modifies the record in the Main form and blanks Subform records. The foreign database
engine is responsible for setting the Match field value(s) to null.
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Deleting a Record
See USER GUIDE Chapter 4 for more information on deleting records.
To delete a record in a form that defines or uses a foreign table, you must have DELETE
permission on the corresponding table.
When you choose Edit>>Delete to delete a record in a form that defines or uses a foreign
table, the record is permanently removed from the disk.
When you choose Edit>>Delete to delete a record in a form that defines or uses a foreign
table and no Unique fields are defined on the form, DataEase displays an informational dialog
box if at least one record in the form is identical to the record on the screen. When you click
OK, all the records that match the one on the screen are deleted.
You cannot recover a deleted record in a form that defines or uses a foreign table. If you
inadvertently delete a record in a foreign table, it must be re-entered.
Note: There should always be at least one Unique field on each form to prevent duplication of
data. If you encounter the dialog displayed above, notify your system administrator.

Deleting a Record in a Multiform
When you try to delete a record in a Multiform, DataEase asks you to specify exactly what you
want to delete by selecting one of several choices. The choices DataEase displays depend on:
(1) which referential integrity option is specified on the Relationships System form and (2)
whether the cursor is in the Main form or a Subform when you choose Edit>>Delete Record.
If the referential integrity option specified on the Relationships form is Server C or Server SN
and the cursor is in the Main form when you choose Edit>>Delete Record, DataEase displays
the Delete Record dialog shown below.

If you choose Cancel, no records are deleted. If you select OK, DataEase deletes the Main
form record. The referential integrity option specified on the server regulates whether the
Subform records are deleted or blanked (see the table below).
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Server-Enforced Referential Integrity When a Record Is
Deleted from a Multiform
Option

When You Delete a Main Form Record, DataEase...

Server C

Only deletes the record in the Main form and leaves the Subform records intact.
The foreign database engine is responsible for deleting Subform records.

Server SN

Deletes the record in the Main form and blanks Subform records. The foreign
database engine is responsible for setting the Match field value(s) to null.

If the referential integrity option specified on the Relationships System form is Server C or
Server SN and the cursor is in the Subform when you choose Edit>>Delete Record,
DataEase displays the Delete Record dialog shown below.

If you select Cancel, no records are deleted. If you choose Main Form (only), DataEase
deletes the Main form record and the effect on Subform records is regulated by the referential
integrity option specified on the server. If you choose Subform (only), DataEase deletes the
current Subform record (only) and leaves the record in the Main form intact.
Note: If the referential integrity option specified on the Relationships form is Server C or
Server SN, the foreign engine, not DataEase, is responsible for enforcing referential integrity.

How Referential Integrity Affects Record Deletion
Delete Records Options
Referential
Integrity
Option

Main Form

Main Form

Subform

(only)

and Its Subforms

(only)

Subform and Its
Nested Subforms

Record(s) DataEase Deletes When the Cursor Is in the Main Form
Restrict

Main form record.
The related
Subform records
continue to exist but
are orphaned.

Main form record
and all Subform
records.

N/A

N/A

Cascade/

N/A

Main form record

N/A

N/A
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Server C

Set Null/
Server SN

and all Subform
records.
N/A

Main form record
and all Subform
records

N/A

N/A

Record(s) DataEase Deletes When the Cursor Is in a Subform
Restrict

Main form record.
The related
Subform records
continue to exist but
are orphaned.

Main form record
and all Subform
records.

Current Subform
record. Leaves any
other Subform
records intact.

Current Subform
record and all
Subform records
nested within it.

Cascade/
Server C

N/A

Main form record
and all Subform
records.

Current Subform
record. Any other
Subform records
are left intact.

Current Subform
record and all
Subform records
nested within it.

Set Null/
Server SN

N/A

Main form record
and all Subform
records.

Current Subform
record. Any other
Subform records
are left intact.

Current Subform
record and all
Subform records
nested within it.

Note:

When the data is accessed on a foreign database engine, the foreign engine is
responsible for maintaining referential integrity.
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Restoring a Deleted Record
See DESIGNER GUIDE Chapter 8 for information on reorganizing a form to recover deleted
records.
When you delete a record in a form that defines or uses a foreign table, the record is removed
from the disk and cannot be recovered unless the following conditions are met:
•

The form is displayed in Table View.

•

You have not pressed Edit>>Save As New Record or Edit>>Save.

To recover a deleted record under these conditions, move the cursor to the deleted record and
choose Edit>>Restore Record.
You can use the same procedure to recover a record deleted from the Main form in a
Multiform.

© DataEase International Ltd

206

INDEX

Abandon Changes, 123

Clear Form, 106

Accessing Foreign Databases, 192

Clear QBF Criteria, 116

Accessing Online Help, 177

Clearing a Field, 115

Active (Window), 29

Clearing a Record, 116

Add all records, 92

Client-Server Terms, 193

Add non-Matching Records, 92

Clipboard Formats, 114

Add or Update Records, 92

Close, 73

Alert Messages, 36

Close Application, 73

All Record Access, 128

Closing a Document, 79

All Records, 82

Closing an Application, 105

All Table Access, 129

Club ParaDEASE, 11

Application, 14

Collate copies, 82

Application Administration, 170

Combining Select and Sort, 163

Application Catalog, 143

Configuring a Printer, 85

Arranging Windows, 173

Continuous Refresh, 129

Ascending, 152

Control Menu Box, 28

Basic (Locking), 190

Copies, 82

Border, 29

Copy, 106

Break a Link, 125

Copy Record, 106

Browsing through Records, 146

Copy Special, 106

Button Actions, 68

Copy Special Dialog, 113

Button and Image Actions, 67

Copying All Record Data, 112

Calculation, 53

Copying Selected Field, 113

Cancel Link, 124

Copyright and Trademarks, 7

Canceling Your Last Action, 109

Corner, 29

Cascade, 117

Creating a New Document, 74

Change Link, 124

Creating a New Record, 48

Change Link Dialog, 125

Creating an Application, 21

Changing the Active Window, 176

Ctrl + D RETURN DATA, 65

Check Mark, 31

Ctrl + End, 54

Choice List, 51

Ctrl + F10 LOOKUP, 64

Clear a New Record, 116

Ctrl + Home, 54

Clear Field, 106

Ctrl + PgDn, 55

© DataEase International Ltd

207

Ctrl + PgUp, 54

Descending, 152

Currency, 51

Designer View, 26, 73, 104

Current Record, 82

Designer View Toolbar, 33

Cursor, 29

Dialog Controls, 35

Cursor Movement, 54

Dialogs, 34

Custom Buttons, 67

Display a Blank Record, 116

Custom Forms, 40

Displaying Sorted Records, 161

Custom Functions Form, 40

Displaying SQL, 145

Custom Help Messages, 183

Displaying the Status Bar, 142

Custom Tab Order, 57

Displaying the Toolbar, 141

Custom Zoom, 138

Document, 15

Customizing Table View, 44

Document Security, 48

Cut, 106

DQL, 16

Data from a Related Form, 149

DQL in Selection Criteria, 167

Data Locking, 48

Edit Link, 124

Database, 14

Edit Menu Options, 106

DataEase Dialogs, 34

Editing Data and Objects, 110

DataEase System Forms, 171

Editing Data Values, 56

DataEase Toolbars, 32

Editing OLE Links, 124

Date, 51

Ellipsis, 31

Default, 52

End, 54

Default Printer, 85

Enter Selection Criteria Using DQL, 166

Delete, 73

Entering and Modifying Records, 106

Delete a Record in a Multiform, 122

Entering Data from Related Forms, 64

Delete a Record in Form View, 122

Exception Files, 94

Delete a Record in Table View, 122

Exit, 73

Delete Record, 106

Exiting DataEase, 26

Delete Record Dialog, 121

Expand Layout, 82

Deleting a Document, 80

Export, 73

Deleting a Record, 71, 121

Export Data Dialog, 99

Deleting an Application, 23

Export File Formats, 99

Deleting Records, 72

Export File Name, 99

Derivation Formula, 52

Exporting Data, 87

© DataEase International Ltd

208

Exporting DataEase Data, 98

How to Create a QBM Report, 169

Extended Date, 51

How to Delete a Field Value, 115

Field, 16

How to Display Field Help, 183

Field Characteristics, 52

How to Enter New Records, 120

Field Name (Import), 90

How to Export Data, 103

Field Order (Import), 90

How to Open a Related Form, 148

Field Security, 53

How to Paste a Field Value, 110

Field Separator, 100

How to Perform a Lookup, 150

Field Separator (Import), 90

How to Print Selected Records, 167

Field Types, 50

How to Return to a Previous Form, 148

File Menu Options, 73

How to Select Records, 156

File Paths, 188

How to Select Text, 108

First Record, 146

How to Specify Sort Criteria, 162

Fixed, 50

How to Use Scroll Bars, 30

Fixed Layout, 82

Import, 73

Fixed Length, 99

Import Checking, 92

Fixed Length Imports, 94

Import Data Dialog, 88

Floating Point, 51

Import File Formats, 89

Form, 15

Import Source Filename, 89

Form Appearance, 39

Importing Data, 87, 88

Form View, 42

Include Field Names, 100

Full (Locking), 190

Insert decimals, 92

Function Keys, 62

Installing DataEase, 188

Generated SQL, 132

Integer, 50

Goto Menu Options, 146

Interoperability, 190

Help Index, 179

Keyboard Shortcut, 31

Help Menu Options, 178

Landscape, 85

Home, 54

Last Record, 146

How fields are sorted, 163

Links, 107

How Records Are Arranged, 44

Links Dialog, 124

How to Clear QBF Criteria, 115

Lock destination table, 92

How to Copy a Field Value, 111

Locking, 48

How to Copy All Data, 112

Locking Configuration, 190

© DataEase International Ltd

209

Login Failure, 77

Opening an Application, 22

Lookup, 52, 146

Operating Systems, 189

Managing Documents, 73

Opportunistic (Locking), 190

Maximize, 29

Options (Print), 85

Menu, 15

Orientation, 85

Menu Bar, 28

Pages, 82

Menus, 31

Paper, 85

Microsoft Windows, 27

Paper Size, 85

Minimize, 29

Password, 22

Modifying a Record, 70

Paste, 106

Modifying OLE Objects, 127

PgDn, 55

Modifying Records, 72

PgUp, 54

Mouse Pointer, 29

Portrait, 85

Multiform, 16

Predefined Format, 50

Multiforms, 41

Prevent Data-entry, 53

Multiple Sessions, 189

Previous Record, 146

Multi-User Applications, 188

Print, 73

Multi-User Environment, 48

Print Dialog Options, 81

Name, 22

Print Selected Pages, 84

New, 73

Print Setup, 73

New Application Dialog, 21

Print Setup Dialog, 85

Next Record, 146

Print the Graphic Objects, 84

No Record Access, 129

Printer, 85

No Table Access, 129

Printing a Document, 81

Nul, 117

Printing All Records, 83

Number, 50

Printing the Current Record, 83

Numeric String, 50

Procedure, 15

Object, 16, 107

QBF, 153

Open, 73

QBM, 153

Open (Window), 29

QBM New Report, 152

Opening a Document, 76, 143

Query, 18

Opening a Record Entry Form, 42

Query By Form (QBF), 18

Opening a Table, 143

Query By Model (QBM), 18

© DataEase International Ltd

210

Query Menu Options, 152

Save As New Record, 106

Range, 82, 113

Saving a Modified Record, 117

Read Record Access, 128

Saving a New Record, 120

Read Table Access, 129

Saving a Record, 69

Record, 16

Saving Records, 72

Record Entry (Client-Server), 196

Scroll Bar, 29

Record Entry Form, 39

Scroll Bars, 30

Record Entry Procedures, 37

Searching for Records, 59

Record Entry Transactions, 196

Select an Area to Zoom, 140

Record Order, 147

Select Records, 152

Record Selection Filter Dialog, 165

Selected Records (Export), 101

Record Separator, 100

Selecting Records, 152, 155

Recover a Deleted Sub Record, 123

Selecting Text, 108

Referential Integrity, 117

Selection Expression Builder, 166

Refresh, 129

Selection Filter, 152

Refresh the Current Record, 131

Sending the Print Job, 83

Related Form, 146

Sequenced ID, 51

Relationship, 18

Server Referential Integrity, 201

Relationships Form, 40

Set Refresh Time, 130

Repair a Broken Link, 126

Shared Applications, 189

Report, 15, 19

Sort Records, 152

Report Form Expansion, 82

Soundex (Wildcard), 159

Required, 52

Source (Paper), 85

Resource Conflict Messages, 49

Source data, 90

Restore, 29

Specific Printer, 85

Restore Record, 106

Specifying Sort Criteria, 162

Restoring a Deleted Record, 123

SQL, 19

Restoring Deleted Records, 72

SQL User Permissions, 197

Restrict, 117

Stand-alone Application Locking, 191

Return Data to, 146

Status Bar, 29

Return to, 146

Storing DataEase Documents, 75

Sales and Support, 7

Subform, 20

Save, 106

System Forms, 40

© DataEase International Ltd

211

Table, 14

Utilities, 170

Table View, 42

Validation Formula, 52

Text, 50

Variable Lengh Imports, 93

Text Delimiter, 100

Variable Length, 99

The DataEase Window, 28

Version Number, 184

The Edit Menu, 106

View, 20

Time, 51

View Menu Options, 132

Title Bar, 29

View Security, 53

Toolbar, 20, 29

Viewing a Catalog List, 143

transaction, 196

Viewing Documents, 25

Triangle, 31

Viewing Records, 58, 132

Undo Typing, 106
Unique, 52

Viewing Records in a Related
Form, 148

Update a Manual Link, 125

Viewing Records in a Report, 58

Update Link, 124

Viewing Records in Sequence,
147

Update Matching Records, 92
Upper/Lower Limit, 52
User Help Dialog, 183
User Permissions, 194
User Privileges, 194
User View, 25, 104
User View Toolbar, 32
Users Form, 40
Using DQL to Select Records, 165
Using Relationships, 64

© DataEase International Ltd

Viewing Related Forms, 64
Viewing Selected Records, 134
Wild Card Characters, 156
Window Menu Options, 173
Write Security, 53
Yes/No, 51
Zoom, 132
Zoom Cascade Menu, 137
Zooming, 136

212

© DataEase International Ltd

